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摘要

本指南说明了如何使用 Red Hat Ceph Storage Dashboard 进行监控和管理。 红帽致力于替换我们的
代码、文档和 Web 属性中存在问题的语言。我们从这四个术语开始：master、slave、黑名单和白名
单。由于此项工作十分艰巨，这些更改将在即将推出的几个发行版本中逐步实施。详情请查看 CTO
Chris Wright 信息。
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第 1 章 CEPH 仪表板概述
作为存储管理员，Red Hat Ceph Storage 控制面板提供管理和监控功能，允许您管理和监控集群，以及
视觉化与其相关的信息和性能统计信息。控制面板使用由 ceph-mgr 守护进程托管的 Web 服务器。

控制面板可从 Web 浏览器访问，包含许多有用的管理和监控功能，例如配置管理器模块并监控 OSD 状
态。

Ceph 仪表板提供以下功能：

多用户和角色管理

控制面板支持多个具有不同权限和角色的用户帐户。可以使用命令行和 Web 用户界面来管理用户帐户
和角色。控制面板支持多种增强密码安全性的方法。可以配置密码复杂性规则，要求用户在登录后或
可配置的时间段后更改密码。
有关更多信息，请参阅在 Ceph 控制面板中管理角色， 并在 Ceph 仪表板上管理用户。

单点登录(SSO)

控制面板支持使用 SAML 2.0 协议通过外部身份提供程序进行身份验证。
有关更多信息 ，请参阅为 Ceph 仪表板启用单点登录。

Auditing

可以将仪表板后端配置为记录 Ceph 管理器日志中的所有 PUT、POST 和 DELETE API 请求。
有关将管理器模块与仪表板搭配使用的更多信息，请参阅 在仪表板上查看和编辑 Ceph 集群的管理器
模块。

管理功能

Red Hat Ceph Storage Dashboard 包括各种管理功能。

查看集群层次结构

例如，您可以查看 CRUSH map，以确定特定 OSD ID 正在运行的主机。这在发生 OSD 的问题时很有
用。
有关更多信息，请参阅 在仪表板上查看 Ceph 集群的 CRUSH map。

配置管理器模块

您可以查看和更改 Ceph 管理器模块的参数。
有关更多信息，请参阅 在仪表板上查看和编辑 Ceph 集群的管理器模块。

嵌入式 Grafana 仪表板

Ceph Dashboard Grafana 仪表板可能会嵌入到外部应用程序和网页中，以使用 Prometheus 模块收集
性能指标的信息。
有关更多信息，请参阅 Ceph 仪表板组件。

查看和过滤日志

您可以查看事件和审计日志，并根据优先级、关键字、日期或时间范围过滤它们。
有关更多信息，请参阅在 仪表板中过滤 Ceph 集群的日志。

切换仪表板组件

您可以启用和禁用仪表板组件，因此只有您需要的功能才可用。
如需更多信息，请参阅 切换 Ceph 仪表板功能。
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管理 OSD 设置

您可以使用控制面板设置集群范围的 OSD 标志。您也可以将 OSD 标记为 up、down 或 out，清除和
重新加权 OSD，执行清理操作，修改各种清理相关配置选项，选择 profile 以调整回填活动级别。您可
以设置和更改 OSD 的设备类别，按设备类别显示和排序 OSD。您可以在新的驱动器和主机上部署
OSD。
有关更多信息，请参阅 在仪表板上管理 Ceph OSD。

查看警报

通过警报页面，您可以查看当前警报的详情。
有关更多信息，请参阅查看 Ceph 仪表板上的警报。

升级

您可以使用控制面板升级 Ceph 集群版本。
如需更多信息，请参阅 升级集群。

镜像的服务质量

您可以设置镜像的性能限制，例如限制 IOPS 或读取 BPS burst 率。
有关更多信息，请参阅在 Ceph 仪表板上管理块设备镜像。

监控功能

监控 Red Hat Ceph Storage Dashboard 中的不同功能。

用户名和密码保护

您只能通过提供可配置的用户名和密码来访问仪表板。
有关更多信息 ，请参阅在 Ceph 仪表板中管理用户。

集群总体健康状况

显示性能和容量指标。这还显示总体集群状态、存储利用率，例如对象数量、原始容量、每个池的使
用情况、池列表及其状态和用量统计。
有关更多信息，请参阅 在仪表板上查看和编辑 Ceph 集群的配置。

主机

提供与集群关联的所有主机的列表，以及正在运行的服务和已安装的 Ceph 版本。
有关更多信息，请参阅在 仪表板中监控 Ceph 集群的主机。

性能计数器

显示每个正在运行的服务的详细统计信息。
有关更多信息，请参阅在 仪表板中监控 Ceph 集群的服务。

Monitors

列出所有 monitor、其仲裁状态和打开的会话。
有关更多信息，请参阅 在仪表板上监控 Ceph 集群的监控器。

配置编辑器

显示所有可用的配置选项、描述、类型、默认值和当前设置的值。这些值可编辑。
有关更多信息，请参阅 在仪表板上查看和编辑 Ceph 集群的配置。

集群日志
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显示并过滤集群事件的最新更新，并根据优先级、日期或关键字审计日志文件。
有关更多信息，请参阅在 仪表板中过滤 Ceph 集群的日志。

设备管理

列出 Orchestrator 已知的所有主机。列出附加到主机的所有驱动器及其属性。显示推动健康预测、
SMART 数据和闪烁的 LED。
有关更多信息，请参阅在 仪表板中监控 Ceph 集群的主机。

查看存储集群容量

您可以在 Ceph 仪表板的 Capacity 页面中查看 Red Hat Ceph Storage 集群的原始存储容量。
有关更多信息，请参阅了解 Ceph 仪表板的登录页面。

池

列出和管理所有 Ceph 池及其详细信息。例如：应用程序、放置组、复制大小、EC 配置集、配额和
CRUSH 规则集。
有关更多信息，请参阅 在仪表板上了解 Ceph 仪表板的登录页面  和监控 Ceph 集群的池。

OSD

列出和管理所有 OSD、其状态和用量统计。OSD 也列出用于读取和写入操作的详细信息，如属性、
OSD map、元数据和性能计数器。OSD 也列出与 OSD 关联的所有驱动器。
有关更多信息，请参阅 在控制面板中监控 Ceph OSD。

镜像

列出所有 Ceph 块设备(RBD)镜像及其属性，如大小、对象和功能。创建、复制、修改和删除 RBD 镜
像。创建、删除和回滚选定镜像的快照，防止或取消保护这些快照以进行修改。复制或克隆快照，扁
平化克隆的镜像。

注意

特定镜像的 Overall Performance 选项卡中的 I/O 性能图仅在通过设置
Cluster→Manager 模块→Prometheus 中的 rbd_stats_pool 参数来指定包含该镜像的
池后才会显示值。

有关更多信息，请参阅 Ceph 仪表板上监控块设备镜像。

块设备镜像

启用并配置 Ceph 块设备(RBD)镜像到远程 Ceph 服务器。列出所有活跃同步守护进程及其状态、池和
RBD 镜像，包括它们的同步状态。
有关更多信息，请参阅 Ceph 仪表板上的镜像视图。

Ceph 文件系统

列出所有活跃的 Ceph 文件系统(CephFS)客户端和相关池，包括它们的用量统计。驱除活跃的
CephFS 客户端，管理 CephFS 配额和快照，并浏览 CephFS 目录结构。
有关更多信息，请参阅在 仪表板中监控 Ceph 文件系统。

对象网关(RGW)

列出所有活跃的对象网关及其性能计数器。显示和管理，包括添加、编辑和删除 Ceph 对象网关用户
及其详细信息，如配额，以及用户的存储桶及其详情，如所有者或配额。
有关更多信息，请参阅 在控制面板中监控 Ceph 对象网关守护进程。
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NFS

使用 NFS Ganesha 管理 CephFS 和 Ceph 对象网关 S3 存储桶的 NFS 导出。
有关更多信息，请参阅在 Ceph 仪表板上管理 NFS Ganesha 导出。

安全功能

控制面板提供以下安全功能：

SSL 和 TLS 支持

Web 浏览器和仪表板之间的所有 HTTP 通信都通过 SSL 进行保护。可以使用内置命令创建自签名证
书，但也可以导入由证书颁发机构(CA)签名和发布的自定义证书。
有关更多信息，请参阅 Ceph 控制面板安装和访问。

先决条件

系统管理员级别体验。

1.1. CEPH DASHBOARD 组件

仪表板的功能由多个组件提供。

用于部署的 Cephadm 应用。

嵌入式仪表板 ceph-mgr 模块。

嵌入的 Prometheus ceph-mgr 模块。

Prometheus 时间序列数据库。

Prometheus node-exporter 守护进程，在存储集群的每个主机上运行。

用于监控用户界面和警报的 Grafana 平台。

其它资源

如需更多信息，请参阅 Prometheus 网站。

如需更多信息，请参阅 Grafana 网站。

1.2. RED HAT CEPH STORAGE DASHBOARD 架构

控制面板架构依赖于 Ceph 管理器仪表板插件和其他组件。请参见以下示意图，以了解 Ceph 管理器和仪
表板如何协同工作。
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第 2 章 CEPH DASHBOARD 安装和访问
作为系统管理员，您可以使用 bootstrap 集群中提供的凭证访问仪表板。

Cephadm 默认安装控制面板。以下是仪表板 URL 的示例：

URL: https://host01:8443/
User: admin
Password: zbiql951ar

注意

更新浏览器，再清除 Cookie，然后再访问仪表板 URL。

以下是可用于 Ceph 仪表板配置的 Cephadm bootstrap 选项：

[-initial-dashboard-user INITIAL_DASHBOARD_USER] - 在 bootstrapping 设置 initial-
dashboard-user 时使用这个选项。

[-initial-dashboard-password INITIAL_DASHBOARD_PASSWORD] - 在 bootstrapping 设置
initial-dashboard-password 时使用该选项。

[–ssl-dashboard-port SSL_DASHBOARD_PORT] - 当 bootstrap 设置自定义仪表板端口而不是默
认的 8443 端口时使用这个选项。

[-dashboard-key DASHBOARD_KEY] - 在 bootstrap 设置用于 SSL 的自定义密钥时使用这个选
项。

[–dashboard-crt DASHBOARD_CRT] - 在 bootstrap 来为 SSL 设置自定义证书时使用这个选
项。

[–skip-dashboard] - 当 bootstrap 在没有仪表板的情况下部署 Ceph 时使用这个选项。

[–dashboard-password-noupdate] - 如果您使用了以上两个选项并不希望在第一次登陆时重置密
码时，在 bootstrap 中使用这个选项。

[-allow-fqdn-hostname] - 在 bootstrap 时使用该选项以允许完全限定的主机名。

[-skip-prepare-host] - 在 bootstrap 时使用该选项跳过主机准备。

注意

为了避免与仪表板相关的外部 URL 连接问题，请将完全限定域名(FQDN)用于主机名，例
如 host01.ceph.redhat.com。

注意

在客户端互联网浏览器中直接打开 Grafana URL，并接受安全例外来查看 Ceph 仪表板上
的图形。重新加载浏览器以查看更改。

示例
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[root@host01 ~]# cephadm bootstrap --mon-ip 127.0.0.1 --registry-json cephadm.txt  --initial-
dashboard-user  admin --initial-dashboard-password zbiql951ar --dashboard-password-noupdate --
allow-fqdn-hostname

注意

在使用 cephadm 增强存储集群时，您可以使用 --image 选项用于自定义容器镜像或本地
容器镜像。

注意

只有在 bootstrap 没有使用 --dashboard-password-noupdate 选项时，您必须在第一次
使用 bootstrap 时更改密码。您可以在 var/log/ceph/cephadm.log 文件中找到 Ceph 仪表
板凭据。使用 "Ceph Dashboard is now available at" 字符串进行搜索。

本节涵盖以下任务：

Ceph 控制面板的网络端口要求。

访问 Ceph 仪表板。

在 Ceph 仪表板上扩展集群。

升级集群。

切换 Ceph 仪表板功能。

了解 Ceph 仪表板的初始页面。

手动启用 Red Hat Ceph Storage Dashboard。

使用 Ceph 仪表板更改仪表板密码。

使用命令行界面更改 Ceph 仪表板密码。

为 Grafana 设置 admin 用户密码。

创建管理员帐户，将用户同步到 Ceph 仪表板。

使用红帽单点登录将用户同步到 Ceph 控制面板。

为 Ceph 控制面板启用单点登录。

为 Ceph 控制面板禁用单点登录。

2.1. CEPH 控制面板的网络端口要求

Ceph 仪表板组件使用某些必须可以被访问的 TCP 网络端口。默认情况下，在安装 Red Hat Ceph
Storage 时，在 firewalld 中自动打开网络端口。

表 2.1. TCP 端口要求
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端口 使用 原始主机 目的地主机

8443 仪表板 Web 界面 需要访问 Grafana 服务
器上的 Ceph Dashboard
UI 和主机的 IP 地址，因
为 AlertManager 服务也
可以启动到 Dashboard
的连接以报告警报。

Ceph 管理器主机。

3000 Grafana 需要访问 Grafana 仪表
板 UI 和所有 Ceph
Manager 主机和
Grafana 服务器的 IP 地
址。

运行 Grafana 服务器的
主机。

2049 NFS-Ganesha 需要访问 NFS 的 IP 地
址。

提供 NFS 服务的 IP 地
址。

9095 基本 Prometheus 图形的
默认 Prometheus 服务器

需要访问 Prometheus UI
以及运行 Prometheus 的
所有 Ceph Manager 主机
和 Grafana 服务器或主
机的 IP 地址。

运行 Prometheus 的主机
或主机。

9093 Prometheus
Alertmanager

需要访问 Alertmanager
Web UI 以及运行
Prometheus 的所有
Ceph Manager 主机和
Grafana 服务器或主机的
IP 地址。

Grafana 服务器下所有
Ceph Manager 主机。

9094 Prometheus
Alertmanager 可配置从
多个实例组成的高可用性
集群

Grafana 服务器下所有
Ceph Manager 主机。

Prometheus
Alertmanager High
Availability（对等点守护
进程同步），因此 src 和
dst 应该都是运行
Prometheus
Alertmanager 的主机。

9100 Prometheus node-
exporter 守护进程

运行 Prometheus 的主机
需要查看节点导出器指标
Web UI 以及运行
Prometheus 的所有
Ceph Manager 主机和
Grafana 服务器或主机。

所有存储集群主机，包括
MON、OSDS、Grafana
服务器主机。

9283 Ceph Manager
Prometheus exporter 模
块

运行 Prometheus 的主机
需要访问 Ceph 导出器
metrics Web UI 和
Grafana 服务器。

所有 Ceph Manager 主
机。
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其它资源

有关更多信息，请参阅 Red Hat Ceph Storage 安装指南。

如需更多信息，请参阅配置和管理网络中的使用和配置防火墙。

2.2. 访问 CEPH 仪表板

您可以访问 Ceph 仪表板来管理和监控 Red Hat Ceph Storage 集群。

先决条件

成功安装 Red Hat Ceph Storage 仪表板。

NTP 正在正确同步时钟。

流程

1. 在网页浏览器中输入以下 URL：

语法

https://HOST_NAME:PORT

替换：

带有活跃管理器主机的完全限定域名(FQDN)的 HOST_NAME。

PORT 带有端口 8443

示例

https://host01:8443

您也可以在 Cephadm shell 中运行以下命令获取仪表板的 URL：

示例

[ceph: root@host01 /]# ceph mgr services

此命令将显示当前配置的所有端点。查找 dashboard 键，以获取用于访问仪表板的 URL。

2. 在登录页面中，输入用户名 admin 和 bootstrap 中提供的默认密码。

3. 首次登录 Red Hat Ceph Storage 仪表板时，您必须更改密码。

4. 登录后，会显示仪表板默认登录页面，其中提供了 Red Hat Ceph Storage 集群的状态、性能、清
单和容量指标的高级别概述。

图 2.1. Ceph 仪表板登录页面
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图 2.1. Ceph 仪表板登录页面

5. 点仪表板登录页面上的菜单图标(  )，折叠或显示垂直菜单中的选项。

其它资源

有关更多信息，请参阅 Red Hat Ceph Storage Dashboard 指南中的使用 Ceph仪表板更改仪表板
密码 。

2.3. 在 CEPH 仪表板中扩展集群

您可以使用控制面板扩展 Red Hat Ceph Storage 集群来添加主机、添加 OSD 和创建服务，如
Alertmanager、Cephadm-exporter、CephFS-mirror、Grafana、ingress、MDS、NFS、node-
exporter、Prometheus、RBD-mirror 和 Ceph 对象网关等服务。

引导新的存储集群后，会创建 Ceph Monitor 和 Ceph Manager 守护进程，集群处于 HEALTH_WARN 状
态。在仪表板上创建集群的所有服务后，集群的健康状况从 HEALTH_WARN 更改为 HEALTH_OK 状态。

先决条件

启动的存储集群。如需了解更多详细信息 ，请参阅 Red Hat Ceph Storage 安装指南中的  引导 新
存储集群部分。

在 Red Hat Ceph Storage 仪表板中，用户至少为 cluster-manager 角色。如需了解更多详细信
息，请参阅 Red Hat Ceph Storage 仪表板指南中的 Ceph仪表板上的用户角色和权限 部分。

流程

1. 将 Bootstrapped 主机中的 admin 密钥复制到其他主机：

语法

ssh-copy-id -f -i /etc/ceph/ceph.pub root@HOST_NAME

示例

[ceph: root@host01 /]# ssh-copy-id -f -i /etc/ceph/ceph.pub root@host02
[ceph: root@host01 /]# ssh-copy-id -f -i /etc/ceph/ceph.pub root@host03
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2. 使用 bootstrap 过程中提供的默认凭证登录到控制面板。

3. 更改密码，再使用新密码登录控制到仪表板。

4. 在登录页面上，单击 Expand Cluster。

注意

点 Expand Cluster 可打开向导，执行扩展步骤。要单独跳过并添加主机和服务，
请点 跳过。

图 2.2. 展开集群

5. 添加主机。这需要针对存储集群中的每个主机完成。

a. 在 Add Hosts 步骤中，单击 Add。

b. 提供主机名。这与从 bootstrapped 主机复制密钥时提供的主机名相同。

注意

使用以逗号分隔的主机名、范围表达式或逗号分隔的范围表达式列表来添加多
个主机。

c. 可选：提供主机的对应 IP 地址。

d. 可选：选择将要创建服务的主机的标签。点击铅笔图标选择或添加新标签。

e. 单击 Add Host。
新主机显示在 Add Hosts 窗格中。

f. 点击 Next。
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6. 创建 OSD：

a. 在 Create OSD 步骤中，对于主设备，单击 Add。

b. 在 主设备 窗口中，过滤该设备并选择设备。

c. 点击 Add。

d. 可选：在 Create OSD 窗口中，如果您有任何共享设备，如 WAL 或 DB 设备，则添加设备。

e. 可选：在 Features 部分中，选择 Encryption 来加密功能。

f. 点击 Next。

7. 创建服务：

a. 在 Create Services 步骤中，单击 Create。

b. 在 Create Service 表单中：

i. 选择服务类型。

ii. 提供服务 ID。ID 是该服务的唯一名称。此 ID 在服务名称中使用，即 
service_type.service_id。

…​可选：如果服务是 Unmanaged，则选择该选项。

+ 选择 Unmanaged 服务时，编配器不会启动或停止与此服务关联的任何守护进程。放置和所有其他属性
都会被忽略。

i. 选择放置是否由主机或标签选择。

ii. 选择主机。

iii. 在 Count 字段中，提供需要部署的守护进程或服务数量。

a. 点 Create Service。
新服务显示在 Create Services 窗格中。

1. 在 Create Service 窗口中，单击 Next。

2. 查看集群扩展详情。
查看 Cluster Resources，即服务主机、主机详情。要编辑任何参数，请点击 Back 并按
照前面的步骤操作。

图 2.3. 查看集群
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3. 单击 Expand Cluster。
此时会显示 Cluster expansion displayed 通知，集群状态在仪表板上更改为
HEALTH_OK。

验证

1. 登录到 cephadm shell：

示例

[root@host01 ~]# cephadm shell

2. 运行 ceph -s 命令。

示例

[ceph: root@host01 /]# ceph -s

集群的运行状况是 HEALTH_OK。

其它资源

如需了解更多详细信息，请参阅 Red Hat Ceph Storage 仪表板指南中的 Ceph仪表板上的用户角
色和权限 部分。

如需了解更多详细信息，请参阅 Red Hat Ceph Storage 安装指南。

2.4. 升级集群

使用控制面板升级 Ceph 集群。

集群镜像从 registry.redhat.io 自动拉取。（可选）使用自定义镜像进行升级。

流程

1. 查看是否有集群升级可用，并根据需要在仪表板上的 Administration > Upgrade 中进行升级。

注意

如果仪表板显示 Not retrieve upgrade 信息，请检查 registry 是否已添加到容器
配置文件中，并具有适当的登录凭证到 Podman 或 docker。

如果需要 ， 在升级过程中点 暂停 或停止。升级进度会在进度栏中显示，以及升级过程中的信息
信息。

注意

在停止升级时，升级会首先暂停，然后提示您停止升级。

2. 可选。在 Upgrade 页面的 Cluster logs 部分查看集群日志。

3. 通过确认集群状态显示 OK 状态来验证升级是否已成功完成。
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2.5. 切换 CEPH 仪表板功能

您可以通过根据需要启用或禁用功能来自定义 Red Hat Ceph Storage 仪表板组件。所有功能都会默认启
用。当禁用某个功能时，web-interface 元素会变为隐藏的，相关的 REST API 端点会拒绝该功能的任何
进一步请求。启用和禁用仪表板功能可以通过命令行界面或 Web 界面完成。

可用功能：

Ceph 块设备：

镜像管理，rbd

镜像，mirroring

Ceph 文件系统，cephfs

Ceph 对象网关, rgw

NFS Ganesha 网关 nfs

注意

默认情况下，Ceph Manager 与 Ceph 监控器共存。

注意

您可以一次性禁用多个功能。

重要

禁用某个功能后，可能需要 20 秒来反映 web 界面中的更改。

先决条件

安装并配置 Red Hat Ceph Storage 仪表板软件。

用户访问 Ceph Manager 主机或控制面板 Web 界面。

对 Ceph Manager 主机的 root 级别访问权限。

流程

从仪表板 web 界面中切换仪表板功能：

a. 在仪表板登录页面中，进入 Administration→Manager Modules 并选择 dashboard 模块。

b. 点 Edit。

c. 在 Edit Manager 模块  表单中，您可以通过选择或清除不同功能名称旁边的复选框来启用或禁
用仪表板功能。

d. 进行选择后，单击 更新。

使用命令行界面切换仪表板功能：

a. 登录到 Cephadm shell：

示例
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示例

[root@host01 ~]# cephadm shell

b. 列出功能状态：

示例

[ceph: root@host01 /]# ceph dashboard feature status

c. 禁用一个功能：

[ceph: root@host01 /]# ceph dashboard feature disable rgw

本例禁用 Ceph 对象网关功能。

d. 启用一个功能：

[ceph: root@host01 /]# ceph dashboard feature enable cephfs

这个示例启用了 Ceph Filesystem 功能。

2.6. 了解 CEPH 仪表板的登录页面

登录页面通过导航栏和单个面板显示整个 Ceph 集群的概述。

菜单栏中提供以下选项：

任务和通知

提供任务和通知消息。

Help

提供 product 和 REST API 文档的链接、有关 Red Hat Ceph Storage 仪表板的详细信息，以及用于报
告问题的格式。

仪表板设置

提供对用户管理和遥测配置的访问权限。

用户

使用此菜单查看登录状态、更改密码和注销仪表板。

图 2.4. 菜单栏中

导航菜单可以通过单击导航菜单图标  来打开或隐藏。

Dashboard

主仪表板显示有关集群状态的特定信息。

可以从导航菜单中点 Dashboard 随时访问主仪表板。
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仪表板登录页面将窗格组织到不同的类别。

图 2.5. Ceph 仪表板登录页面

详情

显示特定的集群信息，如果遥测活跃或不活跃。

Status

显示集群和主机和守护进程状态的健康状态。此时会显示 Ceph 存储集群的当前健康状况。danger 和
warning 警报直接显示在登录页面中。单击 View alerts 以获取完整的警报列表。

容量

显示存储使用指标。这显示为已用、warning 和 danger 的图表。数字以百分比表示，以 GiB 为单位。

清单（Inventory）

显示集群的不同部分、可用数量及其状态。
直接从 清单 链接到特定清单项目，其中可用。

主机

显示 Ceph 存储集群中的主机总数。

Monitors

显示 Ceph 监控器和仲裁状态的数量。

managers

显示管理器守护进程的数量和状态。

OSD

显示 Ceph Storage 集群中的 OSD 总数，以及 中启动的数量、和 的数量。

池

显示 Ceph 集群中的存储池数量。

PGs

显示放置组(PG)的总数。PG 状态划分为 Working 和 Warning，以简化显示。各自包含多个状态。+ 工
作状态包括具有以下状态的 PG：

激活

backfill_wait
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回填

创建

deep

degraded

forced_backfill

forced_recovery

peering

peered

recovering

recovery_wait

repair

清理

snaptrim

snaptrim_wait + Warning 状态包含具有以下状态的 PG：

backfill_toofull

backfill_unfound

down

incomplete

不一致

recovery_toofull

recovery_unfound

remapped

snaptrim_error

stale

undersized

对象网关

显示 Ceph 存储集群中对象网关的数量。

元数据服务器

显示 Ceph 文件系统(CephFS)的元数据服务器的数量和状态。

Cluster Utilization

Cluster Utilization 窗格显示与数据传输速度相关的信息。从列表中选择数据输出的时间范围。选择最
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Cluster Utilization 窗格显示与数据传输速度相关的信息。从列表中选择数据输出的时间范围。选择最
后 5 分钟到最后 24 小时之间的范围。

使用的容量(RAW)

显示 GiB 中的使用量。

IOPS

显示每秒 I/O 读写操作总数。

OSD 冲突

显示每毫秒应用和提交总数。

客户端吞吐量

以每秒 KiB 为单位显示总客户端读取和写入吞吐量。

恢复吞吐量

显示集群修复和平衡操作的速度。例如，显示由于磁盘丢失而可能移动的任何后台数据的状态。该信
息以字节/秒为单位。

其它资源

有关更多信息，请参阅 Red Hat Ceph Storage Dashboard 指南中的在 Ceph仪表板中 监控集群部
分。

2.7. 使用 CEPH 仪表板更改仪表板密码

默认情况下，用于访问仪表板的密码在引导集群时由系统随机生成。首次登录 Red Hat Ceph Storage 仪
表板时，您必须更改密码。您可以使用控制面板更改 admin 用户的密码。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

流程

1. 登录到仪表板：

语法

https://HOST_NAME:8443

2. 进入菜单栏中的 User→Change 密码。

3. 输入旧密码进行验证。

4. 在 New password 字段中，输入新密码。密码必须包含最少 8 个字符，且不能与最后一个字符相
同。

5. 在 Confirm password 字段中，再次输入新密码以确认。

6. 单击 "更改密码  "。
您将退出并重定向到登录屏幕。此时会出现确认密码的通知。

2.8. 使用命令行界面更改 CEPH 仪表板密码

如果您忘记了 Ceph 仪表板密码，您可以使用命令行界面更改密码。
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先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

安装了仪表板的主机的根级别访问。

流程

1. 登录到 Cephadm shell：

示例

[root@host01 ~]# cephadm shell

2. 创建 dashboard_password.yml 文件：

示例

[ceph: root@host01 /]# touch dashboard_password.yml

3. 编辑该文件并添加新仪表板密码：

示例

[ceph: root@host01 /]# vi dashboard_password.yml

4. 重置仪表板密码：

语法

ceph dashboard ac-user-set-password DASHBOARD_USERNAME -i PASSWORD_FILE

示例

[ceph: root@host01 /]# ceph dashboard ac-user-set-password admin -i 
dashboard_password.yml
{"username": "admin", "password": 
"$2b$12$i5RmvN1PolR61Fay0mPgt.GDpcga1QpYsaHUbJfoqaHd1rfFFx7XS", "roles": 
["administrator"], "name": null, "email": null, "lastUpdate": , "enabled": true, 
"pwdExpirationDate": null, "pwdUpdateRequired": false}

验证

使用新密码登录控制面板。

2.9. 为 GRAFANA 设置 ADMIN 用户密码

默认情况下，cephadm 不会为 Grafana 创建管理员用户。使用 Ceph 编排器，您可以创建 admin 用户并
设置密码。

使用这些凭证，您可以使用 admin 用户提供的密码登录到存储集群的 Grafana URL。

先决条件
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先决条件

安装了监控堆栈的 Red Hat Ceph Storage 集群。

cephadm 主机的 root 级别访问权限。

启用 dashboard 模块。

流程

1. 作为 root 用户，创建一个 grafana.yml 文件并提供以下详情：

语法

service_type: grafana
spec:
  initial_admin_password: PASSWORD

示例

service_type: grafana
spec:
  initial_admin_password: mypassword

2. 将 grafana.yml 文件挂载到容器的一个目录中：

示例

[root@host01 ~]# cephadm shell --mount grafana.yml:/var/lib/ceph/grafana.yml

注意

每次退出 shell 时，您都必须在部署守护进程前将该文件挂载到容器中。

3. 可选：检查是否启用了 dashboard Ceph Manager 模块：

示例

[ceph: root@host01 /]# ceph mgr module ls

4. 可选：启用 dashboard Ceph Manager 模块：

示例

[ceph: root@host01 /]# ceph mgr module enable dashboard

5. 使用 orch 命令应用规格：

语法

ceph orch apply -i FILE_NAME.yml
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示例

[ceph: root@host01 /]# ceph orch apply -i /var/lib/ceph/grafana.yml

6. 重新部署 grafana 服务：

示例

[ceph: root@host01 /]# ceph orch redeploy grafana

这会创建一个名为 admin 的 admin 用户，用户具有所给密码，用户可以使用这些凭证登录到
Grafana URL。

验证：

使用凭证登录到 Grafana：

语法

https://HOST_NAME:PORT

示例

https://host01:3000/

2.10. 手动启用 RED HAT CEPH STORAGE DASHBOARD

如果您在引导过程中使用 --skip-dashboard 选项安装了 Red Hat Ceph Storage 集群，仪表板 URL 和凭
证不会出现在引导输出中。您可以使用命令行界面手动启用仪表板。虽然部署了 Prometheus、Grafana、
Alertmanager、Alertmanager 和 node-exporter 等监控堆栈组件，但它们会被禁用，您必须手动启用。

先决条件

在 bootstrap 中使用 --skip-dashboard 选项安装运行的 Red Hat Ceph Storage 集群。

需要启用控制面板的主机的根级别访问权限。

流程

1. 登录到 Cephadm shell：

示例

[root@host01 ~]# cephadm shell

2. 检查 Ceph Manager 服务：

示例

[ceph: root@host01 /]# ceph mgr services

{
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    "prometheus": "http://10.8.0.101:9283/"
}

您可以看到没有配置 Dashboard URL。

3. 启用 dashboard 模块：

示例

[ceph: root@host01 /]# ceph mgr module enable dashboard

4. 为仪表板访问创建自签名证书：

示例

[ceph: root@host01 /]# ceph dashboard create-self-signed-cert

注意

您可以禁用证书验证以避免认证错误。

5. 检查 Ceph Manager 服务：

示例

[ceph: root@host01 /]# ceph mgr services

{
    "dashboard": "https://10.8.0.101:8443/",
    "prometheus": "http://10.8.0.101:9283/"
}

6. 创建 admin 用户和密码以访问 Red Hat Ceph Storage 仪表板：

语法

echo -n "PASSWORD" > PASSWORD_FILE
ceph dashboard ac-user-create admin -i PASSWORD_FILE administrator

示例

[ceph: root@host01 /]# echo -n "p@ssw0rd" > password.txt
[ceph: root@host01 /]# ceph dashboard ac-user-create admin -i password.txt administrator

7. 启用监控堆栈。详情请参阅 Red Hat Ceph Storage Dashboard 指南中的  启用监控堆栈 部分。

其它资源

请参阅 Red Hat Ceph Storage Operations Guide中的使用 Ceph Orchestrator 部署监控堆栈  部
分。
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2.11. 创建管理员帐户，将用户同步到 CEPH 仪表板

您必须创建 admin 帐户，以便将用户同步到 Ceph 仪表板。

在创建了帐户后，请使用 Red Hat Single Sign-on(SSO)将用户同步到 Ceph 仪表板。请参阅 Red Hat
Ceph Storage Dashboard Guide中的使用红帽单点登录部分将用户同步到 Ceph 仪表板  。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

控制面板的管理员级别访问权限。

用户添加到仪表板中。

所有主机上的 root 级别访问权限。

安装了 Java OpenJDK。如需更多信息，请参阅红帽客户门户网站中的 Installing and using
OpenJDK 8 for RHEL 指南中的 Installing a JRE on RHEL by using yum  部分。

从 ZIP 文件安装的 Red Hat Single Sign-On。请参阅红帽客户门户网站上的 Red Hat Single Sign -
On 的 Server 安装和配置指南中的  从 ZIP 文件安装 RH-SSO  部分。

流程

1. 在安装了 Red Hat Ceph Storage 的系统中下载 Red Hat Single Sign-On 7.4.0 服务器 。

2. 解压文件夹：

[root@host01 ~]# unzip rhsso-7.4.0.zip

3. 进入 standalone/configuration 目录并打开 standalone.xml 进行编辑：

[root@host01 ~]# cd standalone/configuration
[root@host01 configuration]# vi standalone.xml

4. 在新创建的 rhsso-7.4.0 文件夹的 bin 目录中，运行 add-user-keycloak 脚本来添加初始管理员
用户：

[root@host01 bin]# ./add-user-keycloak.sh -u admin

5. 将 localhost 和两个 127.0.0.1 实例的所有实例替换为安装 Red Hat SSO 的计算机的 IP 地址。

6. 启动服务器。在 rh-sso-7.4 文件夹的 bin 目录中，运行 独立 引导脚本：

[root@host01 bin]# ./standalone.sh

7. 创建 admin 账户，https: IP_ADDRESS :8080/auth，带有一个用户名和密码：

注意

只有在第一次登录到控制台时，才需要创建一个 admin 帐户。

Red Hat Ceph Storage 7 仪表板指南

26

https://access.redhat.com/documentation/zh-cn/red_hat_ceph_storage/7/html-single/dashboard_guide/#syncing-users-to-the-ceph-dashboard-using-red-hat-single-sign-on_dash
https://access.redhat.com/documentation/zh-cn/openjdk/8/html-single/installing_and_using_openjdk_8_for_rhel/index#installing-jre-on-rhel-using-yum
https://access.redhat.com/documentation/zh-cn/red_hat_single_sign-on/7.4/html-single/server_installation_and_configuration_guide/index#installing_rh_sso_from_a_zip_file
https://access.redhat.com/jbossnetwork/restricted/softwareDetail.html?softwareId=80791&product=core.service.rhsso&version=7.4&downloadType=distributions


8. 使用创建的凭据登录 admin 控制台。

其它资源

要在仪表板上为用户添加角色，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph仪表板中
创建角色 部分。

有关在仪表板上创建用户，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph 仪表板中创建
用户 部分。

2.12. 使用 RED HAT SINGLE SIGN-ON 将用户同步到 CEPH 仪表板

您可以使用红帽单点登录(SSO)与轻量级目录访问协议(LDAP)集成来把用户同步到 Red Hat Ceph
Storage 仪表板。

用户被添加到特定域中，它们可以通过 SSO 访问仪表板，而无需密码进行任何额外的要求。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

控制面板的管理员级别访问权限。

用户添加到仪表板中。请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph 仪表板中创建用户
部分。

所有主机上的 root 级别访问权限。

为同步用户创建的 admin 帐户。请参阅 Red Hat Ceph Storage 仪表板指南中的创建管理员帐
户，以便将用户同步到 Ceph 仪表板部分。

流程

1. 要创建域，点 Master 下拉菜单。在这个域中，您可以提供对用户和应用程序的访问权限。

2. 在 Add Realm 窗口中，输入区分大小写的域名，并将参数 Enabled 设置为 ON，点 Create ：

3. 在 Realm Settings 选项卡中，设置以下参数并点 Save ：

a. enabled - ON
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b. 用户管理的访问 - ON

c. 记录下 SAML 2.0 身份提供商元数据的链接地址，粘贴到 Client Settings 中。

4. 在 Clients 选项卡中，点 Create ：

5. 在 Add Client  窗口中设置以下参数，点 Save ：

a. Client ID - BASE_URL:8443/auth/saml2/metadata

示例

https://example.ceph.redhat.com:8443/auth/saml2/metadata

b. 客户端协议 - saml

6. 在 Client 窗口中，在 Settings 选项卡中设置以下参数：

表 2.2. 客户端设置标签页

参数的名称 语法 示例

客户端 ID BASE_URL:8443/auth/saml2/metadat
a

https://example.ceph.redhat.com:8443
/auth/saml2/metadata

Enabled ON ON

客户端协议 saml saml
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包括 
AuthnState

ment

ON ON

签署文档 ON ON

签名算法 RSA_SHA1 RSA_SHA1

SAML 签名
密钥名称

KEY_ID KEY_ID

有效重定向 
URL

BASE_URL:8443/* https://example.ceph.redhat.com:8443
/*

基本 URL BASE_URL:8443 https://example.ceph.redhat.com:8443
/

Master 
SAML 处理 

URL

https://localhost:8080/auth/realms/RE
ALM_NAME/protocol/saml/descriptor

https://localhost:8080/auth/realms/C
eph_LDAP/protocol/saml/descriptor

参数的名称 语法 示例

注意

从 Realm Settings 选项卡中粘贴 SAML 2.0 身份提供程序元数据的链接。

在 Fine Grain SAML Endpoint Configuration 下，设置以下参数并点 Save ：

表 2.3. 精细的 SAML 配置

参数的名称 语法 示例

Assertion Consumer Service
POST Binding URL

BASE_URL:8443/#/dashboar
d

https://example.ceph.redhat.c
om:8443/#/dashboard

Assertion Consumer Service
Redirect Binding URL

BASE_URL:8443/#/dashboar
d

https://example.ceph.redhat.c
om:8443/#/dashboard

Logout Service Redirect
Binding URL

BASE_URL:8443/ https://example.ceph.redhat.c
om:8443/

7. 在 Clients 窗口的 Mappers 选项卡中，设置以下参数并点 Save ：

表 2.4. 客户端映射程序标签
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参数的名称 Value

协议 saml

名称 username

Mapper Property 用户属性

属性 username

SAML 属性名称 username

8. 在 Clients Scope 选项卡中，选择 role_list ：

a. 在 Mappers 选项卡中，选择 角色列表，将 Single Role Attribute  设置为 ON。

9. 选择 User_Federation 选项卡：

a. 在 User Federation 窗口中，从下拉菜单中选择 ldap ：

b. 在 User_Federation 窗口中，Settings 选项卡设置以下参数，然后单击保存 ：

表 2.5. 用户 Federation Settings 标签页

参数的名称 Value

控制台显示名称 rh-ldap

导入用户 ON

Edit_Mode READ_ONLY

用户名 LDAP 属性 username

RDN LDAP 属性 username

UUID LDAP 属性 nsuniqueid

用户对象类 inetOrgPerson

organizationalPerson rhatPerson

连接 URL 示例：ldap://ldap.corp.redhat.com，点 Test
Connection。您将收到 LDAP 连接成功的通
知。

用户 DN ou=users, dc=example, dc=com

绑定类型 simple
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点 Test authentication。您将收到 LDAP 身份验证成功的通知。

c. 在 Mappers 选项卡中，选择 first name 行并编辑以下参数，然后单击 Save ：

LDAP 属性 - 指定名称

d. 在 User_Federation 选项卡，Settings 选项卡中，点 Synchronize all users:

您将收到用户同步成功完成的通知。

10. 在 Users 选项卡中，搜索添加到仪表板中的用户并点击 Search 图标：
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11. 要查看用户，请点特定行。您应该看到联邦链接，作为提供给用户联邦的名称。

重要

不要手动添加用户，因为用户不会由 LDAP 同步。如果手动添加，点 Delete 来删
除用户。

注意
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注意

如果 Red Hat SSO 当前正在您的工作环境中使用，请务必先启用 SSO。有关更多
信息，请参阅 Red Hat Ceph Storage Dashboard Guide  中的 Enabling Single Sign-
On for the Ceph Dashboard 部分。

验证

用户添加到 realm，控制面板可以使用其电子邮件地址和密码访问 Ceph 仪表板。

示例

https://example.ceph.redhat.com:8443

其它资源

要在仪表板上为用户添加角色，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph仪表板中
创建角色 部分。

2.13. 为 CEPH 仪表板启用单点登录

Ceph 控制面板支持使用安全断言标记语言(SAML)2.0 协议进行外部身份验证。在将单点登录(SSO)与
Ceph 控制面板搭配使用之前，请创建控制面板用户帐户并分配所需的角色。Ceph 控制面板对用户执行授
权，身份验证过程由现有的身份提供程序(IdP)执行。您可以使用 SAML 协议启用单点登录。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

安装 Ceph 控制面板.

对 Ceph Manager 主机的 root 级别访问权限。

流程

1. 要在 Ceph Dashboard 中配置 SSO，请运行以下命令：

语法

cephadm shell CEPH_MGR_HOST ceph dashboard sso setup saml2 
CEPH_DASHBOARD_BASE_URL IDP_METADATA IDP_USERNAME_ATTRIBUTE 
IDP_ENTITY_ID SP_X_509_CERT SP_PRIVATE_KEY

示例

[root@host01 ~]# cephadm shell host01 ceph dashboard sso setup saml2 
https://dashboard_hostname.ceph.redhat.com:8443 idp-metadata.xml username 
https://10.70.59.125:8080/auth/realms/realm_name /home/certificate.txt /home/private-key.txt

替换

CEPH_MGR_HOST 与 Ceph mgr 主机。例如，host01

CEPH_DASHBOARD_BASE_URL 带有可以访问 Ceph 仪表板的基本 URL。
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IDP_METADATA，包含到远程或本地路径的 URL，或 IdP 元数据 XML 的内容。支持的 URL
类型包括 http、https 和 文件。

可选:IDP_USERNAME_ATTRIBUTE，包含用于从身份验证响应中获取用户名的属性。默认为
uid。

可选 ：当 IdP 元数据中存在多个实体 ID 时，使用 IdP 实体 ID 的 IDP_ENTITY_ID。

可选:SP_X_509_CERT，包含 Ceph Dashboard 用来签名和加密的证书文件路径。

可选 ：SP_PRIVATE_KEY 以及 Ceph Dashboard 用来签名和加密的私钥的文件路径。

2. 验证当前的 SAML 2.0 配置：

语法

cephadm shell CEPH_MGR_HOST ceph dashboard sso show saml2

示例

[root@host01 ~]#  cephadm shell host01 ceph dashboard sso show saml2

3. 要启用 SSO，运行以下命令：

语法

cephadm shell CEPH_MGR_HOST ceph dashboard sso enable saml2
SSO is "enabled" with "SAML2" protocol.

示例

[root@host01 ~]#  cephadm shell host01 ceph dashboard sso enable saml2

4. 打开您的仪表板 URL。

示例

https://dashboard_hostname.ceph.redhat.com:8443

5. 在 SSO 页面上，输入登录凭据。SSO 会重定向到仪表板 Web 界面。

其它资源

要禁用单点登录，请参阅 Red Hat Ceph Storage 仪表板指南中的 Ceph  仪表板禁用单点登录。

2.14. 为 CEPH 仪表板禁用单点登录

您可以使用 SAML 2.0 协议禁用 Ceph 控制面板的单点登录。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。
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安装 Ceph 控制面板.

对 Ceph Manager 主机的 root 级别访问权限。

为 Ceph Dashboard 启用单点登录

流程

1. 要查看 SSO 的状态，请运行以下命令：

语法

cephadm shell CEPH_MGR_HOST ceph dashboard sso status

示例

[root@host01 ~]#  cephadm shell host01 ceph dashboard sso status
SSO is "enabled" with "SAML2" protocol.

2. 要禁用 SSO，请运行以下命令：

语法

cephadm shell CEPH_MGR_HOST ceph dashboard sso disable
SSO is "disabled".

示例

[root@host01 ~]#  cephadm shell host01 ceph dashboard sso disable

其它资源

要启用单点登录，请参阅 Red Hat Ceph Storage 仪表板指南中的为 Ceph  仪表板启用单点登录。
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第 3 章 管理 CEPH 仪表板上的角色
作为存储管理员，您可以在仪表板上创建、编辑、克隆和删除角色。

默认情况下，有 8 个系统角色。您可以创建自定义角色，并授予这些角色的权限。这些角色可以根据要求
分配给用户。

本节涵盖了以下管理任务：

Ceph 仪表板上的用户角色和权限。

在 Ceph 控制面板创建角色 .

编辑 Ceph 仪表板上的角色。

在 Ceph 仪表板上克隆角色。

删除 Ceph 仪表板的角色。

3.1. CEPH 仪表板上的用户角色和权限

用户帐户与一组角色关联，它们定义可以访问的特定仪表板功能。

Red Hat Ceph Storage 仪表板功能或模块在安全范围内分组。安全范围是预定义的和静态。Red Hat
Ceph Storage 仪表板中当前可用的安全范围是：

CephFS ：包括与 CephFS 管理相关的所有功能。

config-opt ：包含与 Ceph 配置选项管理相关的所有功能。

dashboard-settings ：允许编辑仪表板设置。

Grafana ：包括与 Grafana 代理相关的所有功能。

Host ：包括与 Hosts 菜单条目相关的所有功能。

log ：包含与 Ceph 日志管理相关的所有功能。

manager: 包含与 Ceph 管理器管理相关的所有功能。

monitor ：包含与 Ceph 监视器管理相关的所有功能。

NFS-ganesha ：包含与 NFS-Ganesha 管理相关的所有功能。

OSD ：包含与 OSD 管理相关的所有功能。

池 ：包含与池管理相关的所有功能。

Prometheus ：包括与 Prometheus 警报管理相关的所有功能。

rbd-image: 包含与 RBD 镜像管理相关的所有功能。

rbd-mirroring ：包含与 RBD 镜像管理相关的所有功能。

rgw ：包含与 Ceph 对象网关(RGW)管理相关的所有功能。

角色指定了一个安全范围和一组权限之间的一组映射。有四种权限 ：
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读

创建

Update（更新）

删除

system roles 列表包括
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administrator ：允许所有安全范围的完整权限。

block-manager ：允许 RBD-image 和 RBD-mirroring 范围的完整权限。

cephfs-manager ：允许 Ceph 文件系统范围的完整权限。

cluster-manager ：允许主机、OSD、监控、管理器和 config-opt 范围的完整权限。

ganesha-manager ：允许 NFS-Ganesha 范围的完整权限。

pool-manager ：允许池范围的完整权限。

read-only ：允许所有安全范围的读取权限，但仪表板设置和 config-opt 范围除外。

rgw-manager ：允许 Ceph 对象网关范围的完整权限。

例如，您需要提供 rgw-manager 对所有 Ceph 对象网关操作的用户的访问权限。

其它资源

有关在 Ceph 控制面板中创建用户，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph 仪表
板中创建用户 部分。

有关在 Ceph 控制面板中创建角色，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph 仪表
板中创建角色 部分。

3.2. 在 CEPH 仪表板上创建角色

您可以在仪表板上创建自定义角色，并且这些角色可以根据其角色分配给用户。

先决条件
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一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

控制面板的管理员级别访问权限。

流程

1. 登录到仪表板。

2. 点 Dashboard Settings 图标，然后点 User Management。

3. 在 Roles 选项卡上，单击 Create。

4. 在 Create Role 窗口中，设置 Name,Description，然后选择此角色的权限，然后单击 Create Role
按钮。
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在本例中，使用 ganesha-manager 和 rgw-manager 角色的用户可以管理所有 NFS-Ganesha
网关和 Ceph 对象网关操作。

5. 您会收到一条通知角色已成功创建。

6. 点行的 Expand/Collapse 图标，以查看提供给角色的详细信息和权限。

其它资源

如需了解更多详细信息，请参阅 Red Hat Ceph Storage 仪表板指南中的 Ceph仪表板上的用户角
色和权限 部分。

如需了解更多详细信息，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph仪表板中创建 用
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如需了解更多详细信息，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph仪表板中创建 用
户部分。

3.3. 编辑 CEPH 仪表板的角色

控制面板允许您在仪表板上编辑角色。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

控制面板的管理员级别访问权限。

在仪表板上创建角色。

流程

1. 登录到仪表板。

2. 点 Dashboard Settings 图标，然后点 User Management。

3. 在 Roles 选项卡上，点击您要编辑的角色。

4. 在 Edit Role 窗口中，编辑参数，然后点 Edit Role。
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5. 您会收到成功更新该角色的通知。

其它资源

如需了解更多详细信息，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph仪表板中创建角
色 部分。

3.4. 在 CEPH 仪表板上克隆角色

当您想要为现有角色分配额外权限时，您可以克隆系统角色并在 Red Hat Ceph Storage 控制面板中进行
编辑。

先决条件
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一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

控制面板的管理员级别访问权限。

角色在仪表板上创建。

流程

1. 登录到仪表板。

2. 点 Dashboard Settings 图标，然后点 User Management。

3. 在 Roles 选项卡上，点击您要克隆的角色。

4. 从 Edit 下拉菜单中选择 Clone。

5. 在 Clone Role 对话框中，输入角色的详细信息，然后单击 Clone Role。

6. 克隆角色后，您可以根据要求自定义权限。

其它资源

如需了解更多详细信息，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph仪表板中创建角
色 部分。

3.5. 删除 CEPH 仪表板的角色

您可以删除您在 Red Hat Ceph Storage 仪表板中创建的自定义角色。

注意

第 3 章 管理 CEPH 仪表板上的角色

43

https://access.redhat.com/documentation/zh-cn/red_hat_ceph_storage/7/html-single/dashboard_guide/#creating-roles-on-the-ceph-dashboard_dash


注意

您无法删除 Ceph 控制面板的系统角色。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

控制面板的管理员级别访问权限。

在仪表板上创建自定义角色。

流程

1. 登录到仪表板。

2. 单击 Dashboard Settings 图标，然后选择 User management。

3. 在 Roles 选项卡上，点击您要删除的角色，然后从操作下拉菜单中选择 Delete。

4. 在 Delete Role 通知中，选择 Yes, I am sure，再单击 Delete Role。

其它资源

如需了解更多详细信息，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph仪表板中创建角
色 部分。
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第 4 章 在 CEPH 仪表板上管理用户
作为存储管理员，您可以在 Red Hat Ceph Storage 仪表板上使用特定角色创建、编辑和删除用户。基于
角色的访问权限控制会根据其角色和要求向每个用户提供。

您还可以在仪表板上创建、编辑、导入、导出和删除 Ceph 客户端身份验证密钥。创建身份验证密钥后，
您可以使用命令行界面(CLI)轮转密钥。密钥轮转符合当前的行业和安全合规性要求。

本节涵盖了以下管理任务：

在 Ceph 控制面板创建用户。

在 Ceph 仪表板上编辑用户。

删除 Ceph 仪表板上的用户。

用户功能

访问功能

创建用户功能

编辑用户功能

导入用户功能

导出用户功能

删除用户功能

4.1. 在 CEPH 仪表板中创建用户

您可以根据其角色在 Red Hat Ceph Storage 仪表板中创建用户，并有足够的角色和权限。例如，如果您
希望用户管理 Ceph 对象网关操作，您可以为该用户提供 rgw-manager 角色。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

控制面板的管理员级别访问权限。

注意

Red Hat Ceph Storage 仪表板不支持更改用户密码时的任何电子邮件验证。此行为是有意
设计的，因为控制面板支持单点登录(SSO)，此功能可以委派给 SSO 提供程序。

流程

1. 登录到仪表板。

2. 点 Dashboard Settings 图标，然后点 User Management。
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3. 在 Users 选项卡中，点 Create。

4. 在 Create User 窗口中，设置 Username 和其他参数，包括角色，然后点 Create User。

5. 您收到用户创建成功的通知。

其它资源

如需了解更多详细信息，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph仪表板中创建角
色 部分。

如需了解更多详细信息，请参阅 Red Hat Ceph Storage 仪表板指南中的 Ceph仪表板上的用户角
色和权限 部分。

4.2. 在 CEPH 仪表板中编辑用户

您可以编辑 Red Hat Ceph Storage 仪表板中的用户。您可以根据要求修改用户的密码和角色。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。
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控制面板的管理员级别访问权限。

在控制面板上创建的用户。

流程

1. 登录到仪表板。

2. 点 Dashboard Settings 图标，然后点 User Management。

3. 要编辑该用户，请点行。

4. 在 Users 选项卡中，从 Edit 下拉菜单中选择 Edit。

5. 在 Edit User 窗口中，编辑 password 和角色等参数，然后点 Edit User。

注意

如果要禁用任何用户对 Ceph 仪表板的访问，可以在 Edit User 窗口中取消选择
Enabled 选项。

6. 您收到用户创建成功的通知。

其它资源
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如需了解更多详细信息，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph仪表板中创建 用
户部分。

4.3. 删除 CEPH 仪表板中的用户

您可以删除 Ceph 仪表板中的用户。有些用户可能会从系统中删除。可以从 Ceph 控制面板删除对此类用
户的访问权限。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

控制面板的管理员级别访问权限。

在控制面板上创建的用户。

流程

1. 登录到仪表板。

2. 点 Dashboard Settings 图标，然后点 User Management。

3. 在 Users 选项卡中，点击您要删除的用户。

4. 从 Edit 下拉菜单中选择 Delete。

5. 在 Delete User notification 中，选择 Yes, I am sure 并点 Delete User。

其它资源

Red Hat Ceph Storage 7 仪表板指南

48

https://access.redhat.com/documentation/zh-cn/red_hat_ceph_storage/7/html-single/dashboard_guide/#creating-users-on-the-ceph-dashboard_dash


如需了解更多详细信息，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph仪表板中创建 用
户部分。

4.4. 用户功能

Ceph 在池内存储数据 RADOS 对象，无论使用的 Ceph 客户端如何。Ceph 用户必须有权访问给定池才能
读取和写入数据，并且必须具有可执行权限才能使用 Ceph 管理的命令。通过创建用户，您可以控制其对
Red Hat Ceph Storage 集群、其池以及池中数据的访问。

Ceph 具有 用户类型 的概念，其始终为 客户端。您需要使用 TYPE.ID 定义用户，其中 ID 是用户 ID，如 
client.admin。此用户输入是因为 Cephx 协议不仅供客户端使用，也使用非客户端，如 Ceph 监控器、
OSD 和元数据服务器。区分用户类型有助于区分客户端用户和其他用户。这种区别简化了访问控制、用
户监控和可追溯性。

4.4.1. 功能

Ceph 使用功能（大写）来描述授予经过身份验证的用户的权限，以操作 monitor、OSD 和元数据服务器
的功能。该功能会根据应用程序标签限制对池中数据、池中的一个命名空间或一组池的访问。Ceph 管理
用户指定在创建或更新用户时用户的功能。

您可以将功能设置为监控、管理器、OSD 和元数据服务器。

Ceph 监控功能包括 r、w 和 x 访问设置。它们可用于聚合使用配置集  NAME的预定义配置集。

OSD 功能包括 r、w、x、class-read 和 class-write 访问设置。它们可用于聚合使用配置集  
NAME的预定义配置集。

Ceph 管理器功能包括 r、w 和 x 访问设置。它们可用于聚合使用配置集  NAME的预定义配置
集。

对于管理员，元数据服务器(MDS)功能包括 allow *。

注意

Ceph 对象网关守护进程(radosgw)是 Red Hat Ceph Storage 集群的客户端，不表示 Ceph
存储集群守护进程类型。

其它资源

如需了解更多详细信息，请参阅访问功能。

4.5. 访问功能

本节介绍可提供给 Ceph 用户或 Ceph 客户端的不同访问或实体功能，如块设备、对象存储、文件系统和
原生 API。

另外，您可以在将角色分配给客户端时描述功能配置集。

allow, 描述

守护进程的以前访问设置。表示只适用于 MDS 的 rw

r, 描述

授予用户 读取访问权限。需要 monitor 来检索 CRUSH map。

w, 描述
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授予用户对对象 的写入访问权限。

x, 描述

授予用户调用类方法（即 读取和写入 ）的能力，并在 monitor 上执行 auth 操作。

class-read, 描述

授予用户调用类读取方法的能力。x 的子集.

class-write, 描述

授予用户调用类写入方法的能力。x 的子集.

*，所有, 描述

授予用户对特定守护进程或 池的读取 、写入和执行权限，以及执行 admin 命令的能力。

以下条目描述了有效的功能配置集：

配置集 osd, 描述

这仅适用于 Ceph Monitor。授予用户权限以 OSD 连接到其他 OSD 或 monitor。在 OSD 上延迟，使
OSD 能够处理复制心跳流量和状态报告。

配置集 mds, 描述

这仅适用于 Ceph Monitor。授予用户权限以 MDS 连接到其他 MDS 或 monitor。

配置集 bootstrap-osd, 描述

这仅适用于 Ceph Monitor。授予用户引导 OSD 的权限。限制部署工具，如 ceph-volume 和 
cephadm，以便在引导 OSD 时具有添加密钥的权限。

配置集 bootstrap-mds, 描述

这仅适用于 Ceph Monitor。授予用户引导元数据服务器的权限。对部署工具（如 cephadm ）进行故
障排除，以便在引导元数据服务器时具有添加密钥的权限。

配置集 bootstrap-rbd, 描述

这仅适用于 Ceph Monitor。授予用户引导 RBD 用户的权限。对部署工具（如 cephadm ）进行故障排
除，以便在引导 RBD 用户时具有添加密钥的权限。

配置集 bootstrap-rbd-mirror, 描述

这仅适用于 Ceph Monitor。授予用户 bootstrap rbd-mirror 守护进程用户的权限。对部署工具（如 
cephadm ）进行故障排除，以便在引导 rbd-mirror 守护进程时具有添加密钥的权限。

profile rbd, 描述

这适用于 Ceph Monitor、Ceph Manager 和 Ceph OSD。授予用户操作 RBD 镜像的权限。当用作
monitor 大写时，它提供了 RBD 客户端应用所需的最小特权；此类特权包括阻止其他客户端用户的功
能。当用作 OSD 上限时，它提供了一个 RBD 客户端应用，具有对指定池的读写访问权限。Manager
大写支持可选的 pool 和 namespace 关键字参数。

profile rbd-mirror, 描述

这仅适用于 Ceph Monitor。授予用户操作 RBD 镜像并检索 RBD 镜像 config-key secret 的权限。它提
供了操作 rbd-mirror 守护进程的用户所需的最小特权。

profile rbd-read-only, 描述

这适用于 Ceph 监控器和 Ceph OSD。授予用户对 RBD 镜像的只读权限。Manager 大写支持可选的 
pool 和 namespace 关键字参数。

profile simple-rados-client, 描述

这仅适用于 Ceph Monitor。授予用户 monitor、OSD 和 PG 数据的只读权限。供直接 librados 客户端
应用使用。

profile simple-rados-client-with-blocklist, 描述

这仅适用于 Ceph Monitor。授予用户 monitor、OSD 和 PG 数据的只读权限。供直接 librados 客户端
应用使用。还包括添加 blocklist 条目以构建高可用性(HA)应用程序的权限。
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配置集 fs-client, 描述

这仅适用于 Ceph Monitor。授予用户 monitor、OSD、PG 和 MDS 数据的只读权限。适用于 CephFS
客户端。

profile role-definer, 描述

这适用于 Ceph Monitor 和 Auth。授予用户 auth 子系统的所有权限，对 monitor 具有只读访问权限，
而不授予其他任何权限。用于自动化工具。警告：除非真正知道您要做的事情，否则不要分配这一
点，因为安全影响会非常大且普遍。

配置集崩溃, 描述

这适用于 Ceph 监控器和 Ceph 管理器。授予用户对 monitor 的只读访问权限。与管理器 crash 模块一
起使用，将守护进程 崩溃转储 上传到监控存储中，以便稍后进行分析。

其它资源

如需了解更多详细信息，请参阅 用户 capabilities_。

4.6. 创建用户功能

在 Ceph 控制面板中，创建具有不同功能的基于角色的访问权限用户。

有关不同用户功能的详情，请查看 用户功能和 访问功能

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

控制面板的管理员级别访问权限。

流程

1. 在仪表板导航中，前往 Administration→Ceph Users。

2. 点 Create。

3. 在 Create User 表单中，提供以下详情：

a. 用户实体 ：输入为 TYPE。ID.

b. Entity ：可以是 mon、mgr、osd 或 mds。

c. 实体功能 ：输入您可以提供给用户的功能。例如，'allow *' 和 profile crash 是可分配给客户
端的一些功能。

注意

您可以根据要求向用户添加更多实体。
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4. 点 Create User.
通知显示用户创建成功。

4.7. 编辑用户功能

在仪表板上编辑用户或客户端的角色。

有关不同用户功能的详情，请查看 用户功能和 访问功能

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

控制面板的管理员级别访问权限。

流程

1. 在仪表板导航中，前往 Administration→Ceph Users。

2. 选择您要编辑的角色的用户。
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3. 点 Edit。

4. 在 Edit User 表单中，根据需要编辑 实体 和实体功能。

注意

您可以根据要求向用户添加更多实体。

5. 单击 编辑用户。
通知显示用户已被成功编辑。

4.8. 导入用户功能

在仪表板上，将用户或客户端的角色从本地主机导入到客户端。

有关不同用户功能的详情，请查看 用户功能和 访问功能

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

控制面板的管理员级别访问权限。

流程

1. 在本地主机上创建密钥环文件：

示例

[localhost:~]$ cat import.keyring

[client.test11]
 key = AQD9S29kmjgJFxAAkvhFar6Af3AWKDY2DsULRg==
 caps mds = "allow *"
 caps mgr = "allow *"
 caps mon = "allow *"
 caps osd = "allow r"

2. 在仪表板导航中，前往 Administration→Ceph Users。

3. 选择您要导出的角色的用户。

4. 选择 Edit→Import。

5. 在 Import User 表单中，单击 Choose File。

6. 浏览本地主机上的文件并选择.

7. 单击 Import User。
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通知显示密钥已被成功导入。

4.9. 导出用户功能

将用户或客户端的角色从控制面板导出到本地主机。

有关不同用户功能的详情，请查看 用户功能和 访问功能

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

控制面板的管理员级别访问权限。

流程

1. 在仪表板导航中，前往 Administration→Ceph Users。

2. 选择您要导出的角色的用户。

3. 从操作下拉列表中选择 Export。

4. 从 Ceph 用户导出数据 对话框，单击 Copy to Clipboard。
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通知显示密钥被成功复制。

5. 在本地系统中创建密钥环文件并粘贴密钥：

示例

[localhost:~]$ cat exported.keyring

[client.test11]
 key = AQD9S29kmjgJFxAAkvhFar6Af3AWKDY2DsULRg==
 caps mds = "allow *"
 caps mgr = "allow *"
 caps mon = "allow *"
 caps osd = "allow r"

6. 单击 Close。

4.10. 删除用户功能

删除仪表板上的用户或客户端的角色。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

控制面板的管理员级别访问权限。

流程

1. 在仪表板导航中，前往 Administration→Ceph Users。

2. 选择您要删除的用户，然后从操作下拉菜单中选择 Delete。

3. 在 Delete user 对话框中，选择 Yes, I am sure。

4. 单击 Delete user。
通知显示用户已被成功删除。
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第 5 章 管理 CEPH 守护进程
作为存储管理员，您可以在 Red Hat Ceph Storage 仪表板上管理 Ceph 守护进程。

5.1. 守护进程操作

Red Hat Ceph Storage 仪表板允许您启动、停止、重启和重新部署守护进程。

注意

除了监控和管理器守护进程外，所有守护进程都支持这些操作。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

在存储集群中至少配置一个守护进程。

流程

您可以通过两种方式管理守护进程。

在 Services 页面中：

1. 在仪表板导航中，前往 Administration→Services。

2. 使用运行该操作的守护进程扩展服务。

注意

行可以随时折叠。

3. 在 Daemons 选项卡中，选择守护进程所在的行。

注意

可以搜索和过滤 Daemons 表。

4. 选择需要在守护进程上运行的操作。选项为 Start,Stop,Restart, 和 Redeploy。

图 5.1. 从服务管理守护进程
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图 5.1. 从服务管理守护进程

在 Hosts 页面中：

1. 在仪表板导航中进入 Cluster→Hosts。

2. 在 Hosts List 选项卡上，展开 host 行，再选择守护进程要对其执行操作的主机。

3. 在主机的 Daemons 选项卡中，选择守护进程所在的行。

注意

可以搜索和过滤 Daemons 表。

4. 选择需要在守护进程上运行的操作。选项为 Start,Stop,Restart, 和 Redeploy。

图 5.2. 从主机管理守护进程
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第 6 章 监控 CEPH 仪表板上的集群
作为存储管理员，您可以使用 Red Hat Ceph Storage Dashboard 根据主机、服务、数据访问方法等来监
控集群的特定方面。

本节涵盖了以下管理任务：

在仪表板上监控 Ceph 集群的主机。

在仪表板上查看和编辑 Ceph 集群的配置。

在仪表板上查看和编辑 Ceph 集群的管理器模块。

在控制面板中监控 Ceph 集群的监控器。

在仪表板中监控 Ceph 集群的服务。

监控仪表板上的 Ceph OSD。

监控仪表板上的 HAProxy。

在控制面板中，查看 Ceph 集群的 CRUSH map。

在仪表板上过滤 Ceph 集群的日志。

在控制面板中查看 Ceph 集群的集中式日志。

在控制面板中监控 Ceph 集群的池。

在仪表板中监控 Ceph 文件系统。

在控制面板中监控 Ceph 对象网关守护进程。

监控 Ceph 控制面板中的块设备镜像。

6.1. 在控制面板中监控 CEPH 集群的主机

您可以在 Red Hat Ceph Storage Dashboard 中监控集群的主机。

以下是主机页面中的不同选项卡。每个标签页包含一个包含 relavent 信息的表。这些表可以按列和行搜索
并自定义。

要更改列的顺序，请选择列名称并拖动以在表中放置。

要选择显示哪些列，点切换列 按钮并选择或清除列名称。

在 line selector 字段中输入要显示的行数。

Devices

此选项卡有一个表，它详细说明设备 ID、设备健康状态的状态、生命周期期望、设备名称、预测创建
日期以及主机上的守护进程。

物理磁盘

此选项卡有一个表，详细说明附加到所选主机的所有磁盘，以及它们的类型、大小等。它的详细信
息，如设备路径、设备类型、可用、供应商、型号、大小和部署 OSD。要识别哪个磁盘位于物理设备
中的位置，请选择设备并点 Identify。选择 LED 应该 blink 的时长，以查找所选磁盘。
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守护进程

此选项卡有一个表，详细说明了在所选主机上部署的所有服务（它们在其中运行的容器），以及它们
的当前状态。表的详情，如守护进程名称、守护进程版本、状态、守护进程上次刷新、CPU 使用量、
内存用量（以 MiB 为单位）和守护进程事件。守护进程操作可以从此选项卡运行。如需了解更多详细
信息，请参阅 守护进程操作。

性能详情

此选项卡具有部署 OSD 的详细信息，如 OSD 部署、CPU 使用量、网络负载、网络丢弃率和 OSD 磁
盘性能统计信息。通过嵌入的 Grafana 仪表板查看性能信息。

设备健康状况

对于启用了 SMART 的设备，您只能在部署 OSD 的 OSD 上获取单个健康状态和 SMART 数据。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

主机添加到存储集群中。

存储集群中部署了所有服务、监控、管理器和 OSD 守护进程。

流程

1. 在仪表板导航中进入 Cluster→Hosts。

2. 在 Hosts List 选项卡上，展开 host 行，再选择守护进程要对其执行操作的主机。

3. 在主机的 Daemons 选项卡中，选择守护进程所在的行。

注意

可以搜索和过滤 Daemons 表。

4. 选择需要在守护进程上运行的操作。选项为 Start,Stop,Restart, 和 Redeploy。

图 6.1. 监控 Ceph 集群的主机
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图 6.1. 监控 Ceph 集群的主机

其它资源

如需了解更多详细信息，请参阅 Red Hat Ceph Storage Administration Guide 中的 Ceph 性能计
数器。

6.2. 在控制面板中查看和编辑 CEPH 集群的配置

您可以在仪表板上查看 Ceph 集群的各种配置选项。您只能编辑一些配置选项。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

所有服务都部署在存储集群中。

流程

1. 在仪表板导航中，进入 Administration→Configuration。

2. 要查看配置的详细信息，请展开行内容。

图 6.2. 配置选项
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图 6.2. 配置选项

3. 可选： 使用搜索字段查找配置。

4. 可选：您可以过滤特定配置。使用以下过滤器：

level - Basic、advanced 或 dev

service - Any、mon、mgr、osd、mds、common、mds_client、rgw 和类似的过滤器。

Source - Any、mon 和类似过滤器

modified - yes 或 no

5. 要编辑配置，请选择配置行，然后单击 Edit。

a. 使用 Edit 表单编辑所需参数，然后点 Update。
通知显示配置已被成功更新。

其它资源

如需了解更多详细信息，请参阅 Red Hat Ceph Storage 配置指南中的 Ceph 网络配置章节。
https://access.redhat.com/documentation/zh-cn/red_hat_ceph_storage/7/html-
single/configuration_guide/#ceph-network-configuration

6.3. 在控制面板中查看和编辑 CEPH 集群的管理器模块

管理器模块用于管理模块特定的配置设置。例如，您可以为集群健康启用警报。

您可以在 Red Hat Ceph Storage 仪表板中查看、启用或禁用集群管理器模块。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。
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已安装仪表板。

查看管理器模块

1. 在仪表板导航中，进入 Administration→Manager Modules。

2. 要查看特定管理器模块的详细信息，请展开行内容。

图 6.3. Manager 模块

启用管理器模块

选择行，然后从操作下拉列表中点 Enable。

禁用 manager 模块

选择行，然后从操作下拉列表中点 Disable。

编辑管理器模块

1. 选择行：

注意

不是所有模块都有可配置参数。如果模块不可配置，则 Edit 按钮被禁用。

2. 编辑所需参数并点 Update。
通知显示该模块已被成功更新。

6.4. 在控制面板中监控 CEPH 集群的监控

您可以在 Red Hat Ceph Storage 仪表板的登录页面上监控 Ceph 监视器的性能，您也可以在 Monitor 面
板中查看 monitor 的详细信息，如状态、仲裁、打开会话数和性能计数器。

先决条件
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先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

监控器部署在存储集群中。

流程

1. 在仪表板导航中，进入 Cluster→Monitors。
Monitor 面板显示有关总体监控状态和监控处于和 out 仲裁的主机的信息。

2. 要查看打开的会话数量，请将光标悬停在 开放会话上。

3. 要查看任何 monitor 的性能计数器，请点击 In Quorum 和 Not In Quorum 表中的 Name。

图 6.4. 查看监控性能计数器

其它资源

请参阅 Red Hat Ceph Storage Operations 指南中的 Ceph监视器 部分。

如需了解更多详细信息，请参阅 Red Hat Ceph Storage Administration Guide 中的 Ceph 性能计
数器。

6.5. 在控制面板中监控 CEPH 集群的服务

您可以在 Red Hat Ceph Storage Dashboard 中监控集群的服务。您可以查看主机名、守护进程类型、守
护进程 ID、容器 ID、容器镜像名称、容器镜像 ID、版本状态以及最后一次刷新的时间等详情。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。
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已安装仪表板。

主机添加到存储集群中。

所有服务都部署在存储集群中。

流程

1. 在仪表板导航中，前往 Administration→Services。

2. 展开该服务以获取更多详细信息。

图 6.5. 监控 Ceph 集群的服务

其它资源

如需了解更多详细信息，请参阅 Red Hat Ceph Storage Operations 指南中的 Ceph
Orchestrators。

6.6. 监控仪表板上的 CEPH OSD

您可以在 Red Hat Ceph Storage Dashboard 的登录页面中监控 Ceph OSD 的状态。您还可以在 OSD 选
项卡中查看主机、状态、设备类、放置组(PG)、大小标志、使用量以及读写操作时间等详情。

以下是 OSD 页面中的不同标签页：

Devices - 此选项卡的详情，如设备 ID、健康状态、生命周期期望、设备名称和主机上的守护进
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Devices - 此选项卡的详情，如设备 ID、健康状态、生命周期期望、设备名称和主机上的守护进
程。

Attributes (OSD map) - 此选项卡显示集群地址、心跳、OSD 状态和其他 OSD 属性的详细信
息。

Metadata - 此选项卡显示 OSD 对象存储、设备、操作系统和内核详细信息的详细信息。

设备健康状况 - 对于启用了 SMART 的设备，您可以获取单个健康状态和 SMART 数据。

性能计数器 - 此选项卡提供了在设备上写入的字节数的详细信息。

性能详细信息 - 此选项卡具有部署 OSD 的详细信息，如 OSD 部署、CPU 使用量、网络负载、网
络降低率和 OSD 磁盘性能统计信息。通过嵌入的 Grafana 仪表板查看性能信息。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

主机添加到存储集群中。

所有服务（包括 OSD）都部署在存储集群中。

流程

1. 在仪表板导航中进入 Cluster→OSDs。

2. 要查看特定 OSD 的详细信息，请从 OSD List 选项卡中扩展 OSD 行。

图 6.6. 监控 Ceph 集群的 OSD
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图 6.6. 监控 Ceph 集群的 OSD

您可以通过单击对应的标签页来查看其他详细信息，如 Devices,Attributes (OSD map),
Metadata,Device Health,Performance counter, 和 Performance Details。

其它资源

如需了解更多详细信息，请参阅 Red Hat Ceph Storage Operations 指南中的 Ceph
Orchestrators。

6.7. 监控仪表板上的 HAPROXY

Ceph 对象网关允许您为单个区域分配多个对象网关实例，以便随着负载增加而横向扩展。由于每个对象
网关实例都有自己的 IP 地址，因此您可以使用 HAProxy 在 Ceph 对象网关服务器之间平衡负载。

您可以在仪表板上监控以下 HAProxy 指标：

HTTP 代码的总响应。

请求/响应总数.

连接总数。

传入/传出字节的当前总数。

您还可以通过运行 ceph dashboard get-grafana-api-url 命令获取 Grafana 详情。

先决条件

Red Hat Ceph Storage 7 仪表板指南

66

https://access.redhat.com/documentation/zh-cn/red_hat_ceph_storage/7/html-single/operations_guide/#ceph-orchestrators


一个正在运行的 Red Hat Ceph Storage 集群。

存储仪表板上的管理级别访问权限。

现有 Ceph 对象网关服务，没有 SSL。如果您希望 SSL 服务，则应在 ingress 服务上配置证书，
而不是 Ceph 对象网关服务。

使用 Ceph 编排器部署的 Ingress 服务。

监控堆栈组件在控制面板上创建。

流程

1. 登录到 Grafana URL 并选择 RGW_Overview 面板：

语法

https://DASHBOARD_URL:3000

示例

https://dashboard_url:3000

2. 验证 Grafana URL 上的 HAProxy 指标。

3. 在 Ceph 仪表板导航中，进入 Object→Gateways。

4. 在 Overall Performance 选项卡中，验证 Ceph 对象网关 HAProxy 指标。

图 6.7. HAProxy 指标

其它资源

如需了解更多详细信息，请参阅 Red Hat Ceph Storage 对象网关指南中的为 Ceph 对象网关配置
高可用性 。

6.8. 在控制面板中查看 CEPH 集群的 CRUSH MAP

您可以查看包含 OSD 列表以及 Red Hat Ceph Storage 仪表板上相关信息的 CRUSH map。CRUSH map
和 CRUSH 算法一起确定数据的保存方式和位置。控制面板允许您查看 CRUSH map 的不同方面，包括
OSD 主机、OSD 守护进程、ID 号、设备类等。

借助 CRUSH map，您可以确定哪些主机上运行一个特定的 OSD ID。如果 OSD 出现问题，这非常有用。

先决条件
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一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

存储集群中部署的 OSD 守护进程。

流程

1. 从仪表板导航中，转至 Cluster→CRUSH 映射。

2. 若要查看特定 OSD 的详细信息，请点它所在的行。

图 6.8. CRUSH 映射详细视图

其它资源

有关 CRUSH map 的更多信息，请参阅 Red Hat Ceph Storage 策略指南中的 CRUSH 管理概述。

6.9. 在控制面板中过滤 CEPH 集群的日志

您可以根据以下标准，查看和过滤 Red Hat Ceph Storage 集群的日志。条件包括 Priority, Keyword,
Date, 和 Time range.

您可以将日志下载到系统中，或者将日志复制到剪贴板，以进行进一步分析。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

由于 Ceph Monitor 是最近一次启动，因此已生成了日志条目。

注意

控制面板日志记录功能仅显示三十最新高级别事件。事件通过 Ceph 监控存储在内存中。
重启 monitor 后的条目会消失。如果您需要查看详细或旧的日志，请参阅基于文件的日
志。

流程
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1. 在仪表板导航中，进入 Observability→Logs。

2. 在 Cluster Logs 选项卡中查看集群日志。

图 6.9. 集群日志

a. 使用 Priority 过滤器按 Debug、Info、Warning、Error 或 All 过滤。

b. 使用 Keyword 字段输入文本，以按关键字进行搜索。

c. 使用 Date picker 根据特定日期过滤。

d. 使用 Time range 字段输入范围，使用 HH:MM - HH:MM 格式。小时需要是数字 0 到 23。

e. 要组合过滤器，请设置两个或多个过滤器。

3. 要保存日志，请使用 Download 或 Copy to Clipboard 按钮。

其它资源

如需更多信息，请参阅 Red Hat Ceph StorageTroubleshooting Guide 中的 配置日志章节。
https://access.redhat.com/documentation/zh-cn/red_hat_ceph_storage/7/html-
single/troubleshooting_guide/#configuring-logging

如需更多信息，请参阅 Red Hat Ceph Storage 故障排除指南中的 了解 Ceph 日志 部分。

6.10. 在控制面板中查看 CEPH 集群的集中日志

Ceph 控制面板允许您查看 Red Hat Ceph Storage 集群中集中空间中的所有客户端的日志，以便有效地监
控。这通过使用 Loki （用于存储和查询日志）的日志聚合系统实现，它是一个将本地日志内容发送到私
有 Grafana Loki 实例的代理。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

Grafana 被配置并登录到集群中。

流程

1. 在仪表板导航中，前往 Administration→Services。

2. 在 Services 中，单击 Create。

3. 在 Create Service 表单中，从 Type 列表中选择 loki。填写剩余的详细信息，然后单击 创建服
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3. 在 Create Service 表单中，从 Type 列表中选择 loki。填写剩余的详细信息，然后单击 创建服
务。

4. 重复上述步骤，以创建 Promtail 服务。从 Type 列表中选择 promtail。
成功创建后，在 Services 表中会显示 loki 和 promtail 服务。

图 6.10. 创建 Loki 和 Promtail 服务

注意

默认情况下，Promtail 服务部署到所有正在运行的主机上。

5. 启用记录到文件。

a. 进入 Administration→Configuration。

b. 选择 log_to_file，然后单击 Edit。

c. 在 Edit log_to_file 表单中，将 global 值设为 true。

图 6.11. 配置日志文件
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图 6.11. 配置日志文件

d. 点 Update。
显示 Updated 配置选项 log_to_file 通知，并返回到 Configuration 表。

e. 对 mon_cluster_log_to_file 重复这些步骤，将全局 值设置为 true。

注意

需要同时配置 log_to_file 和 mon_cluster_log_to_file 文件。

6. 查看集中式日志。

a. 进入 Observability→Logs 并切换到 Daemon Logs 选项卡。使用 Log 浏览器 选择文件，然后
单击 Show logs 以查看该文件中的日志。

图 6.12. 查看集中式日志
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图 6.12. 查看集中式日志

注意

如果没有看到日志，则需要登录到 Grafana 并重新载入页面。

6.11. 在控制面板中监控 CEPH 集群的池

您可以在 Red Hat Ceph Storage Dashboard 中查看集群中池的详情、性能详情、配置和整体性能。

池在 Ceph 存储集群分发和存储数据的方式中发挥着重要作用。如果您在不创建池的情况下部署了集
群，Ceph 将使用默认池来存储数据。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

创建池

流程

1. 在仪表板导航中，进入 Cluster→Pools。

2. 查看 池列表 选项卡，其中提供了数据保护的详细信息以及池所启用的应用程序。对于所需详情，
将鼠标悬停在 Usage、Read bytes 和 Write bytes 上。

3. 展开池行以获取有关特定池的详细信息。

图 6.13. 监控池
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图 6.13. 监控池

4. 有关常规信息，请转至 Overall Performance 选项卡。

其它资源

有关池的更多信息，请参阅 Red Hat Ceph Storage 架构指南中的 Ceph 池。

如需了解更多详细信息，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph仪表板中创建池
部分。

6.12. 监控仪表板上的 CEPH 文件系统

您可以使用 Red Hat Ceph Storage 控制面板监控 Ceph 文件系统(CephFS)和相关组件。

对于列出的每个文件系统，有以下标签：

详情

查看元数据服务器(MDS)及其等级以及任何备用守护进程、池及其用法，以及性能计数器。

目录

查看目录、配额和快照列表。选择一个目录来设置和取消设置最大文件和大小配额，并为特定的目录
创建和删除快照。

子卷

创建、编辑和查看子卷信息。它们可以按子卷组过滤。

子卷组

创建、编辑和查看子卷组信息。

快照

创建、克隆和查看快照信息。它们可以根据子卷组和子卷进行过滤。

快照调度

启用、创建、编辑和删除快照调度。

客户端

查看和驱除 Ceph 文件系统客户端信息。

性能详情

通过嵌入的 Grafana 仪表板查看文件系统的性能。
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先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

MDS 服务至少部署在其中一个主机上。

已安装 Ceph 文件系统。

流程

1. 在仪表板导航中进入 File→File Systems。

2. 要查看有关单个文件系统的更多信息，请展开文件系统行。

其它资源

如需更多信息，请参阅 文件系统指南。

6.13. 在控制面板中监控 CEPH 对象网关守护进程

您可以使用 Red Hat Ceph Storage 控制面板监控 Ceph 对象网关守护进程。您可以查看 Ceph 对象网关守
护进程的详情、性能计数器和性能详情。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

在存储集群中至少配置一个 Ceph 对象网关守护进程。

流程

1. 在仪表板导航中，进入 Object→Gateways。

2. 从 Gateways List 选项卡查看单个网关的信息。

3. 要查看有关单个网关的更多信息，请展开网关行。

4. 如果您配置了多个 Ceph 对象网关守护进程，点 Sync Performance 选项卡并查看多站点性能计
数器。

其它资源

有关更多信息，请参阅 Red Hat Ceph Storage Ceph 对象网关指南。

6.14. 监控 CEPH 仪表板上的块设备镜像

您可以使用 Red Hat Ceph Storage 控制面板监控和管理块设备镜像。您可以查看镜像的详情、快照、配
置详情和性能详情。

先决条件
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一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

创建启用了 rbd 应用的池。

已创建一个镜像。

流程

1. 在仪表板导航中，进入 Block→Images。

2. 展开镜像行以查看详细信息。

图 6.14. 监控块设备镜像

其它资源

如需了解更多详细信息，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph 仪表板中创建镜
像部分。 https://access.redhat.com/documentation/zh-cn/red_hat_ceph_storage/7/html-
single/dashboard_guide/#creating-images-on-the-ceph-dashboard_dash
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第 7 章 在 CEPH 仪表板上管理警报
作为存储管理员，您可以查看警报详情并在 Red Hat Ceph Storage 仪表板中为它们创建静默。这包括以
下预定义警报：

CephadmDaemonFailed

CephadmPaused

CephadmUpgradeFailed

CephDaemonCrash

CephDeviceFailurePredicted

CephDeviceFailurePredictionTooHigh

CephDeviceFailureRelocationIncomplete

CephFilesystemDamaged

CephFilesystemDegraded

CephFilesystemFailureNoStandby

CephFilesystemInsufficientStandby

CephFilesystemMDSRanksLow

CephFilesystemOffline

CephFilesystemReadOnly

CephHealthError

CephHealthWarning

CephMgrModuleCrash

CephMgrPrometheusModuleInactive

CephMonClockSkew

CephMonDiskspaceCritical

CephMonDiskspaceLow

CephMonDown

CephMonDownQuorumAtRisk

CephNodeDiskspaceWarning

CephNodeInconsistentMTU

CephNodeNetworkPacketDrops

CephNodeNetworkPacketErrors
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CephNodeRootFilesystemFull

CephObjectMissing

CephOSDBackfillFull

CephOSDDown

CephOSDDownHigh

CephOSDFlapping

CephOSDFull

CephOSDHostDown

CephOSDInternalDiskSizeMismatch

CephOSDNearFull

CephOSDReadErrors

CephOSDTimeoutsClusterNetwork

CephOSDTimeoutsPublicNetwork

CephOSDTooManyRepairs

CephPGBackfillAtRisk

CephPGImbalance

CephPGNotDeepScrubbed

CephPGNotScrubbed

CephPGRecoveryAtRisk

CephPGsDamaged

CephPGsHighPerOSD

CephPGsInactive

CephPGsUnclean

CephPGUnavilableBlockingIO

CephPoolBackfillFull

CephPoolFull

CephPoolGrowthWarning

CephPoolNearFull

CephSlowOps
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PrometheusJobMissing

图 7.1. 预定义的警报
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您还可以使用简单网络管理协议(SNMP)陷阱来监控警报。

7.1. 启用监控堆栈

您可以使用命令行界面手动启用 Red Hat Ceph Storage 集群的监控堆栈，如 Prometheus、
Alertmanager 和 Grafana。

您可以使用 Prometheus 和 Alertmanager API 来管理警报和静默。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

对所有主机的根级别访问权限。

流程

1. 登录 cephadm shell：

示例

[root@host01 ~]# cephadm shell

2. 为监控堆栈设置 API：
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a. 指定 Alertmanager 服务器的主机和端口：

语法

ceph dashboard set-alertmanager-api-host ALERTMANAGER_API_HOST:PORT

示例

[ceph: root@host01 /]# ceph dashboard set-alertmanager-api-host http://10.0.0.101:9093
Option ALERTMANAGER_API_HOST updated

b. 要查看配置的警报，请将 URL 配置为 Prometheus API。使用此 API 时，Ceph 控制面板 UI
会验证新静默是否与对应的警报匹配。

语法

ceph dashboard set-prometheus-api-host PROMETHEUS_API_HOST:PORT

示例

[ceph: root@host01 /]# ceph dashboard set-prometheus-api-host http://10.0.0.101:9095
Option PROMETHEUS_API_HOST updated

设置主机后，刷新浏览器的仪表板窗口。

指定 Grafana 服务器的主机和端口：

语法

ceph dashboard set-grafana-api-url GRAFANA_API_URL:PORT

示例

[ceph: root@host01 /]# ceph dashboard set-grafana-api-url https://10.0.0.101:3000
Option GRAFANA_API_URL updated

3. 获取 Prometheus、Alertmanager 和 Grafana API 主机详情：

示例

[ceph: root@host01 /]# ceph dashboard get-alertmanager-api-host
http://10.0.0.101:9093
[ceph: root@host01 /]# ceph dashboard get-prometheus-api-host
http://10.0.0.101:9095
[ceph: root@host01 /]# ceph dashboard get-grafana-api-url
http://10.0.0.101:3000

4. 可选： 如果您在 Prometheus、Alertmanager 或 Grafana 设置中使用自签名证书，请在仪表板
中禁用证书验证，这样可避免拒绝由未知证书颁发机构(CA)签名的证书导致的连接，或者与主机
名不匹配。

对于 Prometheus：
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示例

[ceph: root@host01 /]# ceph dashboard set-prometheus-api-ssl-verify False

对于 Alertmanager：

示例

[ceph: root@host01 /]# ceph dashboard set-alertmanager-api-ssl-verify False

对于 Grafana：

示例

[ceph: root@host01 /]# ceph dashboard set-grafana-api-ssl-verify False

5. 获取 Prometheus、Alertmanager 和 Grafana 的自签名证书验证设置详情：

示例

[ceph: root@host01 /]# ceph dashboard get-prometheus-api-ssl-verify
[ceph: root@host01 /]# ceph dashboard get-alertmanager-api-ssl-verify
[ceph: root@host01 /]# ceph dashboard get-grafana-api-ssl-verify

6. 可选：如果仪表板没有反映更改，则必须禁用并启用仪表板：

示例

[ceph: root@host01 /]# ceph mgr module disable dashboard
[ceph: root@host01 /]# ceph mgr module enable dashboard

其它资源

请参阅 Red Hat Ceph Storage 安装指南中的 Bootstrap 命令选项 部分。

请参阅 Red Hat Ceph Storage 安装指南中的 Red Hat Ceph Storage 安装章节。

请参阅 Red Hat Ceph Storage Operations Guide中的使用 Ceph Orchestrator 部署监控堆栈 部
分。

7.2. 配置 GRAFANA 证书

cephadm 使用 ceph 键/值存储中定义的证书部署 Grafana。如果没有指定证书，cephadm 会在部署
Grafana 服务过程中生成一个自签名证书。

您可以使用 ceph config-key set 命令配置自定义证书。

前提条件

一个正在运行的 Red Hat Ceph Storage 集群。

流程
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1. 登录 cephadm shell：

示例

[root@host01 ~]# cephadm shell

2. 为 Grafana 配置自定义证书：

示例

[ceph: root@host01 /]# ceph config-key set mgr/cephadm/grafana_key -i $PWD/key.pem
[ceph: root@host01 /]# ceph config-key set mgr/cephadm/grafana_crt -i 
$PWD/certificate.pem

3. 如果已经部署了 Grafana，则运行 reconfig 以更新配置：

示例

[ceph: root@host01 /]# ceph orch reconfig grafana

4. 每次添加新证书时，请按照以下步骤操作：

a. 创建新目录

示例

[root@host01 ~]# mkdir /root/internalca
[root@host01 ~]# cd /root/internalca

b. 生成密钥：

示例

[root@host01 internalca]# openssl ecparam -genkey -name secp384r1 -out $(date 
+%F).key

c. 查看密钥：

示例

[root@host01 internalca]# openssl ec -text -in $(date +%F).key | less

d. 发出请求：

示例

[root@host01 internalca]# umask 077; openssl req -config openssl-san.cnf -new -sha256 
-key $(date +%F).key -out $(date +%F).csr

e. 在发送签名前查看请求：

示例
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[root@host01 internalca]# openssl req -text -in $(date +%F).csr | less

f. 作为 CA 签名：

示例

[root@host01 internalca]# openssl ca -extensions v3_req -in $(date +%F).csr -out $(date 
+%F).crt -extfile openssl-san.cnf

g. 检查签名的证书：

示例

[root@host01 internalca]# openssl x509 -text -in $(date +%F).crt -noout | less

其它资源

如需了解更多详细信息，请参阅使用共享系统证书。

7.3. 添加 ALERTMANAGER WEBHOOK

您可以向现有 Alertmanager 配置添加新 webhook，以接收有关存储集群运行状况的实时警报。您必须启
用传入的 webhook，以允许将消息异步到第三方应用程序中。

例如，如果一个 OSD 在 Red Hat Ceph Storage 集群中停机，您可以将 Alertmanager 配置为在 Google
chat 上发送通知。

前提条件

正在运行的 Red Hat Ceph Storage 集群启用了监控堆栈组件。

在接收第三方应用程序上配置的传入 Webhook。

流程

1. 登录 cephadm shell：

示例

[root@host01 ~]# cephadm shell

2. 将 Alertmanager 配置为使用 Webhook 进行通知：

语法

service_type: alertmanager
spec:
  user_data:
    default_webhook_urls:
    - "_URLS_"

default_webhook_urls 是添加到默认接收器 webhook_configs 配置中的额外 URL 列表。
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示例

service_type: alertmanager
spec:
  user_data:
    webhook_configs:
    - url: 'http:127.0.0.10:8080'

3. 更新 Alertmanager 配置：

示例

[ceph: root@host01 /]#  ceph orch reconfig alertmanager

验证

从 Alertmanager 到 Gchat 的通知示例：

示例

using: https://chat.googleapis.com/v1/spaces/(xx- space identifyer -xx)/messages
posting: {'status': 'resolved', 'labels': {'alertname': 'PrometheusTargetMissing', 'instance': 
'postgres-exporter.host03.chest
response: 200
response: {
"name": "spaces/(xx- space identifyer -xx)/messages/3PYDBOsIofE.3PYDBOsIofE",
"sender": {
"name": "users/114022495153014004089",
"displayName": "monitoring",
"avatarUrl": "",
"email": "",
"domainId": "",
"type": "BOT",
"isAnonymous": false,
"caaEnabled": false
},
"text": "Prometheus target missing (instance postgres-exporter.cluster.local:9187)\n\nA 
Prometheus target has disappeared. An e
"cards": [],
"annotations": [],
"thread": {
"name": "spaces/(xx- space identifyer -xx)/threads/3PYDBOsIofE"
},
"space": {
"name": "spaces/(xx- space identifyer -xx)",
"type": "ROOM",
"singleUserBotDm": false,
"threaded": false,
"displayName": "_privmon",
"legacyGroupChat": false
},
"fallbackText": "",
"argumentText": "Prometheus target missing (instance postgres-
exporter.cluster.local:9187)\n\nA Prometheus target has disappea
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"attachment": [],
"createTime": "2022-06-06T06:17:33.805375Z",
"lastUpdateTime": "2022-06-06T06:17:33.805375Z"

7.4. 在 CEPH 仪表板上查看警报

触发警报后，您可以在 Red Hat Ceph Storage 控制面板查看它。您可以编辑 Manager 模块 设置，以便在
触发警报时触发邮件。

前提条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

配置了简单邮件传输协议(SMTP)。

发出的警报。

流程

1. 在仪表板导航中，进入 Observability→Alerts。

2. 从 Active Alerts 选项卡中查看活跃的 Prometheus 警报。

3. 从 Alerts 选项卡中查看所有警报。
要查看警报详情，请展开警报行。

4. 要查看警报的来源，请单击其行，然后单击 Source。

其他资源

有关配置 SMTP 的详情 ，请参阅使用 Ceph Manager 警报模块。

7.5. 在 CEPH 仪表板上创建静默

您可以在 Red Hat Ceph Storage 仪表板中针对指定时间为警报创建静默。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

触发警报。
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流程

1. 在仪表板导航中，进入 Observability→Alerts。

2. 在 Silences 选项卡上，单击 Create。

3. 在 Create Silence 表单中，填写所需字段。

a. 使用 Add matcher 添加静默要求。

图 7.2. 创建静默

4. 点击 Create Silence。
通知显示静默创建成功，以及 Silences 表中的 Alerts Silenced 更新。

7.6. 在 CEPH 仪表板上重新创建静默

您可以在 Red Hat Ceph Storage Dashboard 上的静默中重新创建静默。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

触发警报。
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为警报创建的静默。

流程

1. 在仪表板导航中，进入 Observability→Alerts。

2. 在 Silences 选项卡中，选择包含您要重新创建的警报的行，然后从操作下拉列表中点 Recreate。

3. 编辑任何需要的详情，点 Recreate Silence 按钮。
通知显示表示静默被成功编辑，静默的状态现在为。

7.7. 在 CEPH 仪表板上编辑静默

您可以编辑活跃的静默，例如在 Red Hat Ceph Storage 仪表板中扩展它处于活跃状态的时间。如果静默
已到期，可以重新创建静默或为警报创建新静默。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

触发警报。

为警报创建的静默。

流程

1. 登录到仪表板。

2. 在导航菜单中点 Cluster。

3. 从下拉菜单中选择 Monitoring。

4. 点 Silences 选项卡。

5. 要编辑静默，请点击它的行。

6. 在 Edit 下拉菜单中，选择 Edit。

7. 在 Edit Silence 窗口中，更新详情并点 Edit Silence。

图 7.3. 编辑静默
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图 7.3. 编辑静默

8. 您会收到成功更新静默的通知。

7.8. 在 CEPH 仪表板中将静默设置为过期

您可以使静默到期，以便在 Red Hat Ceph Storage 仪表板中不隐藏匹配的警报。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

触发警报。

为警报创建的静默。

流程

1. 在仪表板导航中，进入 Observability→Alerts。
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2. 在 Silences 选项卡中，选择包含您要过期警报的行，然后从操作下拉列表中点 Expire。

3. 在 Expire Silence 通知中，选择 Yes, I am sure 并点 Expire Silence。
通知显示，表示静默成功过期，且警报的 Status 在 Silences 表中 过期。

其它资源

有关更多信息，请参阅 Red Hat Ceph StorageTroubleshooting 指南。
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第 8 章 在 CEPH 仪表板上管理 NFS GANESHA 导出
作为存储管理员，您可以管理将 Ceph 对象网关用作 Red Hat Ceph Storage 仪表板上的后备存储的 NFS
Ganesha 导出。您可以在仪表板上部署并配置、编辑和删除 NFS ganesha 守护进程。

控制面板管理 Ceph 群集上 RADOS 对象中存储的 NFS-Ganesha 配置文件。NFS-Ganesha 必须将其配置
的一部分存储在 Ceph 集群中。

8.1. 在 CEPH 控制面板中配置 NFS GANESHA 守护进程

在配置 Ceph 对象网关并使用 命令行界面为 NFS-Ganesha 启用专用的池后，您可以在控制面板上配置
NFS Ganesha。

注意

Red Hat Ceph Storage 5 仅支持 NFSv4 协议。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

已安装 Ceph 对象网关。

Ceph 对象网关登录凭据添加到控制面板中。

启用专用池并标记带有 nfs 标签的自定义池。

Ceph 控制面板中至少具有 ganesha-manager 级别的访问权限。

流程

1. 登录到 Cephadm shell：

示例

[root@host01 ~]# cephadm shell

2. 创建 RADOS 池、命名空间并启用 rgw ：

语法

ceph osd pool create POOL_NAME _
ceph osd pool application enable POOL_NAME freeform/rgw/rbd/cephfs/nfs

示例

[ceph: root@host01 /]# ceph osd pool create nfs-ganesha
[ceph: root@host01 /]# ceph osd pool application enable nfs-ganesha rgw

3. 在命令行界面中使用放置规格部署 NFS-Ganesha 网关：
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语法

ceph orch apply nfs SERVICE_ID --placement="NUMBER_OF_DAEMONS HOST_NAME_1 
HOST_NAME_2 HOST_NAME_3"

示例

[ceph: root@host01 /]# ceph orch apply nfs foo --placement="2 host01 host02"

这会部署一个 NFS-Ganesha 集群 nfsganesha，并在 host01 和 host02 上有一个守护进程。

4. 使用命名空间和 service_ID 更新 ganesha-clusters-rados-pool-namespace 参数：

语法

ceph dashboard set-ganesha-clusters-rados-pool-namespace POOL_NAME/SERVICE_ID

示例

[ceph: root@host01 /]# ceph dashboard set-ganesha-clusters-rados-pool-namespace nfs-
ganesha/foo

5. 在仪表板导航中进入 File→NFS。

6. 点 Create。

7. 在 Create NFS 导出 表单中，设置以下参数并点 Create NFS export ：

a. 集群 - 集群的名称。

b. 守护进程 - 您可以选择所有守护进程。

c. 存储后端 - 您可以选择 Object Gateway。

d. Object Gateway User - 选择创建的用户。在本例中，它是 test_user。

e. Path - 任何目录。

f. NFS 协议 - 默认选择 NFSv4。

g. Pseudo - root 路径

h. 访问类型 - 支持的访问类型是 RO、RW 和 NONE。

i. Squash

j. 传输协议

k. 客户端
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8. 验证 NFS 守护进程是否已配置：

示例

[ceph: root@host01 /]# ceph -s

9. 作为 root 用户，检查 NFS-service 是否活跃并在运行：

示例

[root@host01 ~]# systemctl list-units | grep nfs

10. 挂载 NFS 导出并执行几个 I/O 操作。

11. NFS 服务启动后，在 NFS-RGW 容器中，注释掉 etc/ganesha/ganesha.conf 文件中的 
dir_chunk=0 参数。重启 NFS-Ganesha 服务。这允许在 NFS 挂载上正确列出。

验证

您可以通过进入 Object→Buckets 来查看 NFS 守护进程。
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其它资源

有关在仪表板中添加对象网关登录凭证的更多信息，请参阅 Red Hat Ceph Storage Dashboard
指南中的 手动将对象网关登录凭证添加到仪表板 部分。

有关在控制面板上创建对象网关用户的更多信息，请参阅 Red Hat Ceph Storage 仪表板指南中的
在仪表板上创建 Ceph对象网关用户 部分。

有关在控制面板上创建对象网关存储桶的更多信息，请参阅 Red Hat Ceph Storage 仪表板指南中
的在仪表板上创建 Ceph 对象网关存储桶  部分。

如需有关系统角色的更多信息，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph 仪表板上
管理角色 部分。

8.2. 在 CEPH 控制面板中使用 CEPHFS 配置 NFS 导出

在配置 Ceph 文件系统(CephFS)后，您可以使用命令行界面在 Ceph 仪表板中创建、编辑和删除 NFS 导
出。您可以通过 NFS 协议导出 CephFS 命名空间。

您需要创建一个 NFS 集群，为所有 NFS Ganesha 守护进程创建通用恢复池，基于 CLUSTER_ID 的新用
户，以及通用 NFS Ganesha 配置 RADOS 对象。

注意

Red Hat Ceph Storage 5 仅支持 NFSv4 协议。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

对 bootstrap 启动主机的 root 级别访问权限。

Ceph 控制面板中至少具有 ganesha-manager 级别的访问权限。

流程

1. 登录到 cephadm shell：

示例

[root@host01 ~]# cephadm shell

2. 在后端中创建 CephFS 存储：
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语法

ceph fs volume create CEPH_FILE_SYSTEM

示例

[ceph: root@host01 /]# ceph fs volume create cephfs

3. 启用 Ceph Manager NFS 模块：

示例

[ceph: root@host01 /]# ceph mgr module enable nfs

4. 创建 NFS Ganesha 集群：

语法

ceph nfs cluster create NFS_CLUSTER_NAME "HOST_NAME_PLACEMENT_LIST"

示例

[ceph: root@host01 /]# ceph nfs cluster create nfs-cephfs host02
NFS Cluster Created Successfully

5. 获取仪表板 URL：

示例

[ceph: root@host01 /]# ceph mgr services
{
    "dashboard": "https://10.00.00.11:8443/",
    "prometheus": "http://10.00.00.11:9283/"
}

6. 使用您的凭据登录 Ceph 仪表板。

7. 在仪表板登录页面上，单击 NFS。

8. 点 Create。

9. 在 Create NFS 导出 窗口中，设置以下参数并点 Create NFS export ：

a. 集群 - 集群的名称。

b. 守护进程 - 您可以选择所有守护进程。

c. 存储后端 - 您可以选择 CephFS。

d. CephFS User ID - 选择创建 NFS 集群的服务。

e. CephFS Name - 提供用户名。
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f. CephFS Path - 任何目录。

g. NFS 协议 - 默认选择 NFSv4。

h. Pseudo - root 路径

i. 访问类型 - 支持的访问类型是 RO、RW 和 NONE。

j. Squash - 选择 squash 类型。

k. 传输协议 - 选择 UDP 或 TCP 协议。

l. 客户端

图 8.1. CephFS NFS 导出窗口

10. 在客户端主机上以 root 用户身份创建一个目录并挂载 NFS 导出：

语法

mkdir -p /mnt/nfs/
mount -t nfs -o port=2049 HOSTNAME:EXPORT_NAME _MOUNT_DIRECTORY_

示例
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[root@ client ~]# mkdir -p /mnt/nfs/
[root@ client ~]# mount -t nfs -o port=2049 host02:/export1 /mnt/nfs/

验证

验证 NFS 守护进程是否已配置：

示例

[ceph: root@host01 /]# ceph -s

其它资源

如需了解更多详细信息 ，请参阅 Red Hat Ceph Storage Operations 指南中的使用 Ceph
Orchestrator 创建 NFS-Ganesha 集群部分。

8.3. 在 CEPH 控制面板中编辑 NFS GANESHA 守护进程

您可以在 Red Hat Ceph Storage 仪表板上编辑 NFS Ganesha 守护进程。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

Ceph 控制面板中至少具有 ganesha-manager 级别的访问权限。

控制面板中配置的 NFS Ganesha 守护进程。

流程

1. 在仪表板导航中，前往 Object → NFS。

2. 选择需要编辑的行。然后单击 Edit。

3. 在 Edit NFS 导出 窗口中，编辑所需的参数。

4. 通过单击 编辑 NFS 导出 来完成。
通知显示 NFS 对象已被成功更新。

第 8 章 在 CEPH 仪表板上管理 NFS GANESHA 导出

97

https://access.redhat.com/documentation/zh-cn/red_hat_ceph_storage/7/html-single/operations_guide/#creating-the-nfs-ganesha-cluster-using-the-ceph-orchestrator_ops


其它资源

有关配置 NFS Ganesha 的更多信息，请参阅 Red Hat Ceph Storage Dashboard 指南中的在
Ceph 仪表板上配置 NFS Ganesha 守护进程 部分。

有关在仪表板中添加对象网关登录凭证的更多信息，请参阅 Red Hat Ceph Storage
Dashboard指南中的手动将 Ceph 对象网关登录凭证添加到仪表板 部分。

有关在控制面板上创建对象网关用户的更多信息，请参阅 Red Hat Ceph Storage 仪表板指南中的
在 仪表板上 创建对象网关用户部分。

有关在控制面板上创建对象网关存储桶的更多信息，请参阅 Red Hat Ceph Storage Dashboard
指南中的在仪表板上创建 Ceph 对象网关存储桶部分。

如需有关系统角色的更多信息，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph 仪表板上
管理角色 部分。

8.4. 删除 CEPH 仪表板上的 NFS GANESHA 守护进程
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Ceph 仪表板允许您删除 NFS Ganesha 守护进程。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

Ceph 控制面板中至少具有 ganesha-manager 级别的访问权限。

控制面板中配置的 NFS Ganesha 守护进程。

流程

1. 在仪表板导航中进入 File→NFS。

2. 选择需要删除的行，并从操作下拉列表中点 Delete。

3. 在 Delete NFS 导出通知中，选择 Yes, I am sure 并点 Delete NFS export 。

验证

所选行将被成功删除。

其它资源

有关配置 NFS Ganesha 的更多信息，请参阅 Red Hat Ceph Storage Dashboard 指南中的 在
Ceph 仪表板上配置 NFS Ganesga 守护进程。

有关在仪表板中添加对象网关登录凭证的更多信息，请参阅 Red Hat Ceph Storage
Dashboard指南中的手动将 Ceph 对象网关登录凭证添加到仪表板 部分。

有关在控制面板上创建对象网关用户的更多信息，请参阅 Red Hat Ceph Storage 仪表板指南中的
在 仪表板上 创建对象网关用户部分。

有关在控制面板上创建对象网关存储桶的更多信息，请参阅 Red Hat Ceph Storage Dashboard
指南中的在仪表板上创建 Ceph 对象网关存储桶部分。

如需有关系统角色的更多信息，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph 仪表板上
管理角色 部分。
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第 9 章 在 CEPH 仪表板上管理池
作为存储管理员，您可以在 Red Hat Ceph Storage 仪表板上创建、编辑和删除池。

本节涵盖了以下管理任务：

在 Ceph 控制面板创建池。

在 Ceph 仪表板上编辑池。

删除 Ceph 仪表板上的池。

9.1. 在 CEPH 仪表板上创建池

当您在没有创建池的情况下部署存储集群时，Ceph 将使用默认池来存储数据。您可以在 Red Hat Ceph
Storage 仪表板中创建一个池来对存储对象进行逻辑分区。

先决条件

一个正在运行的 Red Hat Ceph Storage 集群。

已安装仪表板。

流程

1. 在仪表板导航中，进入 Cluster→Pools。

2. 点 Create。

3. 填写 Create Pool 表单。

图 9.1. 创建池
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图 9.1. 创建池

注意

表单的变化基于选择。并非所有字段都是必需的。

设置池的名称，然后选择池类型。

选择 池类型，可以是 replicated 或 erasure。纠删代码称为 Erasure Coded (EC)。

可选：如果 PG Autoscale 处于、off 或 warn，则选择。
       

        可选：如果使用复制池类型，请设置复制的大小。
       

        可选：如果使用 EC 池类型，请配置以下附加设置。
       

第 9 章 在 CEPH 仪表板上管理池

101



        可选： 要查看当前所选 EC 配置集的设置，请点问号。
       

        可选：点加号符号添加新 EC 配置集。
       

        可选：点击铅笔图标为池选择应用程序。
       

        可选：设置 CRUSH 规则（如果适用）。
       

        可选：如果需要压缩，请选择 passive, aggressive, 或 force。
       

        可选：设置配额。
       

        可选：设置服务质量配置。
       

4. 
      要保存更改并完成池创建，请单击 Create Pool。
     

      通知显示池创建成功。
     

其它资源

      有关更多信息，请参阅 Red Hat Ceph Storage 架构指南中的 Ceph池  部分以了解更多详细
信息。
     

9.2. 在 CEPH 仪表板中编辑池

    您可以编辑 Red Hat Ceph Storage 仪表板中的池。
   

先决条件

      一个正在运行的 Red Hat Ceph Storage 集群。
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      已安装仪表板。
     

      已创建一个池。
     

流程

1. 
      在仪表板导航中，进入 Cluster→Pools。
     

2. 
      要编辑池，请选择池行，再单击 Edit。
     

3. 
      在 Edit Pool 表单中，编辑所需的参数。
     

4. 
      点 Edit Pool 保存更改。
     

      通知显示池已被成功更新。
     

其它资源

      如需更多信息，请参阅 Red Hat Ceph Storage 架构指南中的 Ceph 池。
     

      有关压缩模式的更多信息，请参阅 Red Hat Ceph Storage 策略指南中的池 值。
     

9.3. 删除 CEPH 仪表板上的池

    您可以删除 Red Hat Ceph Storage 仪表板中的池。在 Manager 模块中，确保将  
mon_allow_pool_delete 的值设为 True。
   

先决条件

      一个正在运行的 Red Hat Ceph Storage 集群。
     

      已安装仪表板。
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      已创建一个池。
     

流程

1. 
      在仪表板导航中，进入 Administration→Configuration。
     

2. 
      从 Configuration 表中，选择 mon_allow_pool_delete，然后单击 Edit。
     

注意

       如果需要，请清除过滤器并搜索配置。
      

3. 
      从 Edit mon_allow_pool_delete 表单（在 Values 中），将所有值设置为 true。
     

4. 
      点 Update。
     

      通知显示配置已被成功更新。
     

5. 
      进入 Cluster→Pools。
     

6. 
      选择要删除的池，然后从操作下拉菜单中选择 Delete。
     

7. 
      在 Delete Pool 对话框中，通过单击 Delete Pool 选择 Yes, I am sure. and complete。
     

      通知显示池已被成功删除。
     

其它资源

      如需更多信息，请参阅 Red Hat Ceph Storage 架构指南中的 Ceph 池。
     

      有关压缩模式的更多信息，请参阅 Red Hat Ceph Storage 策略指南中的池 值。
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第 10 章 管理 CEPH 仪表板上的主机

   作为存储管理员，您可以在 Red Hat Ceph Storage Dashboard 中为主机启用或禁用维护模式。维护
模式可确保关闭主机来执行维护活动，不会损害集群。
  

   您还可以使用 Red Hat Ceph Storage Dashboard 中的 Start Drain 和 Remove 选项删除主机。
  

   本节涵盖了以下管理任务：
  

     进入维护模式。
    

     退出维护模式。
    

     使用 Ceph 控制面板删除主机。
    

先决条件

     一个正在运行的 Red Hat Ceph Storage 集群。
    

     已安装仪表板。
    

     主机、Ceph 监控和 Ceph 管理器守护进程添加到存储集群中。
    

10.1. 进入维护模式

    在 Red Hat Ceph Storage Dashboard 上关机之前，您可以进入主机进入维护模式。如果维护模式成
功启用，则主机将会脱机，且执行维护活动的任何错误。如果维护模式失败，这表明失败的原因和在关闭
主机前需要执行的操作。
   

先决条件

      一个正在运行的 Red Hat Ceph Storage 集群。
     

第 10 章 管理 CEPH 仪表板上的主机

105



      已安装仪表板。
     

      所有其他预备性检查都由 Ceph 在内部执行，并且 Ceph 内部获取任何可能的错误。
     

流程

1. 
      在仪表板导航中进入 Cluster→Hosts。
     

2. 
      选择要进入维护模式的主机，然后从操作下拉菜单中选择 Enter Maintenance。
     

注意

       如果主机包含 Ceph 对象网关(RGW)守护进程，则会显示删除 RGW 守护进程
的警告可能会导致客户端丢失连接。单击 Continue 以进入维护。
      

注意

       当主机进入维护模式时，所有守护进程都会停止。通过扩展主机视图并切换到 
Daemons 选项卡，检查主机守护进程的状态。
      

      通知显示主机已被成功移到 maintance。
     

验证

1. 
      Maintenance 标签显示在 Host 表的 Status 列中。
     

注意

       如果维护模式失败，则会显示通知，指示失败的原因。
      

10.2. 退出维护模式

    要重启主机，您可以在 Red Hat Ceph Storage Dashboard 上移出维护模式。
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先决条件

      一个正在运行的 Red Hat Ceph Storage 集群。
     

      已安装仪表板。
     

      所有其他预备性检查都由 Ceph 在内部执行，并且 Ceph 内部获取任何可能的错误。
     

流程

1. 
      在仪表板导航中进入 Cluster→Hosts。
     

2. 
      选择当前处于维护模式的主机，然后从操作下拉菜单中选择 Exit Maintenance。
     

注意

       通过检查 Host 表中的 Status 列中的 Maintenance 标签来识别哪个主机处于
维护状态。
      

      通知显示主机已成功移出维护。
     

3. 
      在主机上创建所需的服务。默认情况下，会部署 crash 和 node-exporter。
     

验证

1. 
      Maintenance 标签已从 Host 表的 Status 列中删除。
     

10.3. 使用 CEPH 仪表板删除主机

    要从 Ceph 集群中删除主机，您可以在 Red Hat Ceph Storage Dashboard 中使用 Start Drain 和 
Remove 选项。
   

先决条件
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      一个正在运行的 Red Hat Ceph Storage 集群。
     

      已安装仪表板。
     

      所有其他预备性检查都由 Ceph 在内部执行，并且 Ceph 内部获取任何可能的错误。
     

流程

1. 
      在仪表板导航中进入 Cluster→Hosts。
     

2. 
      选择要删除的主机，然后从操作下拉菜单中选择 Start Drain。
     

图 10.1. 选择 Start Drain 选项

    + 此选项排空主机中的所有守护进程。
   

    +
   

注意

     _no_schedule 标签自动应用到主机，这会阻止在此主机上部署守护进程。
    

a. 
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a. 
      可选： 要停止主机中的守护进程排空，请从操作下拉列表中点 Stop Drain。
     

1. 
        检查所有守护进程是否已从主机移除。
       

b. 
      展开 host 行。
     

c. 
      转至 Daemons 选项卡。不应列出守护进程。
     

图 10.2. 检查主机守护进程的状态

重要

       在所有守护进程都移除后，可以从集群中安全地删除主机。
      

1. 
        选择要删除的主机，然后单击操作下拉菜单中的 Remove。
       

d. 
      在 Remove Host 通知中，选择 Yes, I am sure 并点 Remove Host。
     

第 10 章 管理 CEPH 仪表板上的主机

109



      通知显示主机已被成功删除。
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第 11 章 在控制面板中管理 CEPH OSD

   作为存储管理员，您可以在 Red Hat Ceph Storage 控制面板中监控和管理 OSD。
  

   Red Hat Ceph Storage 仪表板的一些功能有：
  

     列出 OSD、其状态、统计信息、属性、元数据、设备运行状况、性能计数器和性能详情。
    

     将 OSD 关机标记为 down，即丢失、清除、重新加权、清理、深度清理、删除和选择 
profile，以调整回填活动。
    

     列出与 OSD 关联的所有驱动器。
    

     设置并更改 OSD 的设备类。
    

     在新的驱动器和主机上部署 OSD。
    

先决条件

     正在运行的 Red Hat Ceph Storage 集群
    

     在 Red Hat Ceph Storage 仪表板上的 cluster-manager 访问级别
    

11.1. 在 CEPH 仪表板上管理 OSD

    您可以在 Red Hat Ceph Storage Dashboard 上对 Ceph OSD 执行以下操作：
   

      创建新 OSD。
     

      编辑 OSD 的设备类。
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      将标记标记为 No Up,No Down,No In，或 No Out。
     

      刮除和深度刮除 OSD。
     

      重新加权 OSD。
     

      将 OSD 标记为 Out, In, Down, 或 Lost。
     

      清除 OSD。
     

      销毁 OSD。
     

      删除 OSD。
     

先决条件

      一个正在运行的 Red Hat Ceph Storage 集群。
     

      已安装仪表板。
     

      主机、监控和管理器守护进程添加到存储集群中。
     

流程

     在仪表板导航中进入 Cluster→OSDs。
    

创建 OSD

1. 
      要创建 OSD，请从 OSD List 表中单击 Create。
     

图 11.1. 为 OSD 添加设备
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图 11.1. 为 OSD 添加设备

注意

       确定您有可用的主机和几个可用的设备。检查 Cluster→Physical Disks 中可
用的设备，并过滤 Available。
      

a. 
        在 Create OSD 表单的 Deployment Options 部分中，选择以下选项之一：
       

          Cost/Capacity-optimized ：集群使用所有可用的 HDD 部署。
         

          Throughput-optimized ：最低设备用于存储数据，使用更快速的设备来存储日志/
设备。
         

          IOPS-optmized ：所有可用的 NVMe 设备都用于部署 OSD。
         

b. 
        在 Advanced Mode 部分中，点 Add 添加主、WAL 和 DB 设备。
       

          主设备 ：主存储设备包含所有 OSD 数据。
         

          WAL 设备 ： Write-Ahead-Log 设备用于 BlueStore 的内部日志，且仅在 WAL 
设备比主设备快时使用。例如： NVMe 或 SSD 设备。
         

          DB 设备 ：数据库设备用于存储 BlueStore 的内部元数据，且仅在 DB 设备比主设
备更快时使用。例如： NVMe 或 SSD 设备。
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c. 
        要加密您的数据，出于安全目的，请从表单的 Features 部分中选择 Encryption。
       

d. 
        单击 Preview。
       

e. 
        在 OSD Creation Preview 对话框中，检查 OSD，再单击 Create。
       

        通知显示 OSD 已成功创建，并且 OSD 状态从 in 和 down 变为 in 和 up。
       

编辑 OSD

1. 
      若要编辑 OSD，请选择行，再单击 Edit。
     

a. 
        从 Edit OSD 表单，编辑设备类。
       

b. 
        单击 Edit OSD。
       

图 11.2. 编辑 OSD

        通知显示 OSD 已成功更新。
       

标记 OSD 标记

1. 
      要标记 OSD 的标志，请选择行，然后从操作下拉列表中点 Flags。
     

2. 
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2. 
      在单个 OSD 标记 表单中，选择所需的 OSD 标志。
     

3. 
      点 Update。
     

图 11.3. 标记 OSD 标记

      通知显示 OSD 标志已被成功更新。
     

清理 OSD

1. 
      要清理 OSD，请选择行，然后从操作下拉列表中单击 Scrub。
     

2. 
      在 OSD Scrub 通知中，单击 Update。
     

图 11.4. 清理 OSD
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图 11.4. 清理 OSD

      通知显示 OSD 的清理成功启动。
     

深度刮除 OSD

1. 
      要深度清理 OSD，请选择行，然后从操作下拉列表中点 Deep Scrub。
     

2. 
      在 OSD Deep Scrub 通知中，单击 Update。
     

图 11.5. 深度刮除 OSD

      通知显示 OSD 的深度清理成功启动。
     

重新加权 OSD

1. 
      要重新加权 OSD，请选择行，然后从操作下拉列表中点 Reweight。
     

2. 
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2. 
      在 Reweight OSD 表单中，输入 0 到 1 之间的值。
     

3. 
      点 Reweight。
     

图 11.6. 重新加权 OSD

标记 OSD out

1. 
      要将 OSD 标记为 out，请选择行，然后从操作下拉列表中单击 Mark Out。
     

2. 
      在 Mark OSD out 通知中，单击 Mark Out。
     

图 11.7. 标记 OSD out

      OSD 状态更改为 out。
     

将 OSD 标记为 in

1. 
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1. 
      要将 OSD 标记为 in，可选择处于 out 状态的 OSD 行，然后从操作下拉列表中点 Mark In。
     

2. 
      在通知 中的 Mark OSD 中，单击 Mark In。
     

图 11.8. 将 OSD 标记为 in

      OSD 状态更改为 中的。
     

标记 OSD 停机

1. 
      要标记 OSD 停机，请从操作下拉列表中选择行并单击 Mark Down。
     

2. 
      在 Mark OSD down 通知中，点 Mark Down。
     

图 11.9. 标记 OSD 停机

      OSD 状态更改为 down。
     

标记 OSD lost
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1. 
      要标记 丢失的 OSD，可选择 OSD 处于 out 和 down 状态，然后从操作下拉列表中点 Mark 
Lost。
     

2. 
      在 Mark OSD Lost 通知中，选择 Yes, I am sure 并点 Mark Lost。
     

图 11.10. 标记 OSD lost

清除 OSD

1. 
      要清除 OSD，可选择 OSD 处于 down 状态，然后从操作下拉列表中点 Purge。
     

2. 
      在 Purge OSD 通知中，选择 Yes, I am sure，再单击 Purge OSD。
     

图 11.11. 清除 OSD
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图 11.11. 清除 OSD

      所有标志都已重置，并且 OSD in 和 up 状态。
     

销毁 OSD

1. 
      若要销毁 OSD，可选择 OSD 处于 down 状态，然后从操作下拉列表中选择 Destroy。
     

2. 
      在 Destroy OSD 通知中，选择 Yes, I am sure，再单击 Destroy OSD。
     

图 11.12. 销毁 OSD
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图 11.12. 销毁 OSD

      OSD 状态更改为已 销毁。
     

删除 OSD

1. 
      若要删除 OSD，请选择 OSD，再从操作下拉列表中单击 Delete。
     

2. 
      在 Delete OSD 通知中，选择 Yes, I am sure，再单击 Delete OSD。
     

注意

       当需要替换失败的 OSD 时，可以保留 OSD_ID。
      

图 11.13. 删除 OSD
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图 11.13. 删除 OSD

11.2. 替换 CEPH 仪表板上的故障 OSD

    您可以将 Red Hat Ceph Storage 集群中的故障 OSD 替换为仪表板上访问的 cluster-manager 级
别。控制面板中的这一功能的亮点之一是，在替换故障 OSD 时可以保留 OSD ID。
   

先决条件

      一个正在运行的 Red Hat Ceph Storage 集群。
     

      至少需要 cluster-manager 级别访问 Ceph 控制面板。
     

      至少一个 OSD 为 down
     

流程

1. 
      在仪表板中，您可以使用以下方法识别失败的 OSD：
     

        仪表板 AlertManager 弹出通知。
       

Red Hat Ceph Storage 7 仪表板指南

122



        仪表板登录页面，显示 HEALTH_WARN 状态。
       

        显示故障 OSD 的仪表板登录页面。
       

        显示故障 OSD 的仪表板 OSD 页面。
       

        在本例中，您可以看到其中一个 OSD 在仪表板的登录页面上停机。
       

        如果其中一个 OSD 停机，您也可以查看物理驱动器上的 LED blinking light。
       

2. 
      从 Cluster→OSDs，在 OSD 列表 表中选择 out 和 down OSD。
     

a. 
        单击操作下拉菜单中的 Flags，在单个 OSD 标记 表单中选择 No Up，然后单击 
Update。
       

b. 
        从操作下拉列表中点 Delete。在 Delete OSD 通知中，选择 Preserve OSD ID for 
replacement 和 Yes, I am sure，再单击 Delete OSD。
       

c. 
        等待 OSD 的状态变为 out 和 destroyed。
       

3. 
      可选： 要更改整个集群的 No Up Flag，请从 集群范围的配置 菜单中选择 Flags。
     

a. 
        在 集群范围的 OSD 标记 表单中，选择 No Up 并点 Update。
       

4. 
      可选：如果 OSD 由于硬盘失败而停机，请替换物理驱动器：
     

        如果驱动器支持热插拔，请将失败的驱动器替换为新驱动器。
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        如果驱动器不可热插拔并且主机包含多个 OSD，您可能需要关闭整个主机并替换物理驱
动器。考虑防止集群回填。详情请参阅 Red Hat Ceph Storage 故障排除指南中的停止和启
动 重新平衡 章节。
       

        当驱动器出现在 /dev/ 目录下时，请注意驱动器路径。
       

        如果要手动添加 OSD，找到 OSD 驱动器并格式化磁盘。
       

        如果新磁盘有数据，则 zap 磁盘：
       

语法

         

ceph orch device zap HOST_NAME PATH --force

        

示例

         

ceph orch device zap ceph-adm2 /dev/sdc --force

        

5. 
      从 Ceph 控制面板 OSD 列表，单击 Create。
     

6. 
      在 Create OSD 表单 Advanced Mode 部分中，添加一个主设备。
     

a. 
        在 主设备 对话框中，选择一个 主机名 过滤器。
       

b. 
        从列表中选择一个设备类型。
       

注意
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注意

         您必须首先选择 Hostname，然后至少一个过滤器来添加设备。
        

        例如，从 Hostname 列表中选择 Type，然后选择 hdd。
       

c. 
        选择 Vendor 和 from device 列表中，选择 ATA。
       

d. 
        点击 Add。
       

e. 
        在 Create OSD 表单中，单击 Preview。
       

f. 
        在 OSD Creation Preview 对话框中，单击 Create。
       

        通知显示 OSD 已成功创建，并且 OSD 更改处于 out 和 down 状态。
       

7. 
      选择新创建的具有 out 和 down 状态的 OSD。
     

a. 
        从操作下拉列表中点 Mark In。
       

b. 
        在通知 中的 Mark OSD 中，单击 Mark In。
       

        OSD 状态更改为 中的。
       

c. 
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c. 
        从操作下拉列表中点 Flags。
       

d. 
        清除 No Up selection 并点 Update。
       

8. 
      可选： 如果您在集群范围的配置前更改了 No Up 标志，在 集群范围的配置 菜单中选择 
Flags。
     

a. 
        在 集群范围的 OSD 标记 表单中，清除 No Up selection 并点 Update。
       

验证

1. 
      验证已销毁的 OSD 是否在设备上创建，并且 OSD ID 已被保留。
     

其它资源

      有关故障 OSD 的更多信息，请参阅 Red Hat Ceph Storage 故障排除指南中的 故障 OSD 部
分。
     

      如需了解更多帮助，请参阅  Red Hat Ceph Storage 故障排除指南中的红帽对服务的支持 部
分。
     

      如需有关系统角色的更多信息，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph 仪
表板上管理角色 部分。
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第 12 章 使用控制面板管理 CEPH 对象网关

   作为存储管理员，仪表板的 Ceph 对象网关功能允许您管理和监控 Ceph 对象网关。
  

   您还可以使用控制面板创建使用安全套接字层(SSL)的 Ceph 对象网关服务。
  

   例如，借助监控功能，您可以查看网关守护进程（如其区域名称）或 GET 和 PUT 速率的性能图形的详
细信息。通过管理功能，您可以查看、创建和编辑用户和存储桶。
  

   Ceph 对象网关功能在用户功能和 bucket 功能之间划分。
  

12.1. 手动将 CEPH 对象网关登录凭据添加到仪表板中

    Red Hat Ceph Storage 控制面板可以管理 Ceph 对象网关，也称为 RADOS 网关或 RGW。使用  
cephadm 部署 Ceph 对象网关时，会自动配置控制面板使用的 Ceph 对象网关凭据。您也可以使用 命令
行界面手动将 Ceph 对象网关凭据强制到 Ceph 控制面板。
   

先决条件

      一个正在运行的 Red Hat Ceph Storage 集群。
     

      已安装仪表板。
     

      已安装 Ceph 对象网关。
     

流程

1. 
      登录到 Cephadm shell：
     

示例

       

[root@host01 ~]# cephadm shell
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2. 
      手动设置凭证：
     

示例

       

[ceph: root@host01 /]# ceph dashboard set-rgw-credentials

      

      这会为系统中的每个域创建一个 Ceph 对象网关用户，其具有 UID dashboard。
     

3. 
      可选：如果您在 Ceph Object Gateway admin API 中配置了自定义 admin 资源，则必须设
置 admin 资源：
     

语法

       

ceph dashboard set-rgw-api-admin-resource RGW_API_ADMIN_RESOURCE

      

示例

       

[ceph: root@host01 /]# ceph dashboard set-rgw-api-admin-resource admin
Option RGW_API_ADMIN_RESOURCE updated

      

4. 
      可选： 如果您将 HTTPS 与自签名证书搭配使用，请在仪表板中禁用证书验证以避免拒绝的
连接。
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      如果证书由未知证书颁发机构签名，或者所使用的主机名与证书中的主机名不匹配，则拒绝的
连接可能会发生。
     

语法

       

ceph dashboard set-rgw-api-ssl-verify false

      

示例

       

[ceph: root@host01 /]# ceph dashboard set-rgw-api-ssl-verify False
Option RGW_API_SSL_VERIFY updated

      

5. 
      可选：如果对象网关需要很长时间来处理请求，并且仪表板运行超时，您可以设置超时值：
     

语法

       

ceph dashboard set-rest-requests-timeout _TIME_IN_SECONDS_

      

      默认值为 45 秒。
     

示例

       

[ceph: root@host01 /]# ceph dashboard set-rest-requests-timeout 240
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12.2. 使用控制面板通过 SSL 创建 CEPH 对象网关服务

    安装 Red Hat Ceph Storage 集群后，您可以使用以下两种方法使用 SSL 创建 Ceph 对象网关服务：
   

      使用命令行界面。
     

      使用控制面板.
     

先决条件

      一个正在运行的 Red Hat Ceph Storage 集群。
     

      已安装仪表板。
     

      来自认证机构(CA)的 SSL 密钥。
     

注意

     从与网关主机名匹配的 CA 获取 SSL 证书。红帽建议从带有 subject alternate name 
字段和通配符的 CA 获取证书，用于 S3-style 子域。
    

流程

1. 
      在仪表板导航中，前往 Administration→Services。
     

2. 
      点 Create。
     

3. 
      填写 Create Service 表单。
     

a. 
        从 Type 服务列表中选择 rgw。
       

b. 
        输入 service_id 中使用的 ID。
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c. 
        选择 SSL。
       

d. 
        点 Choose File 并上传 SSL 证书 .pem 格式。
       

图 12.1. 创建 Ceph 对象网关服务

e. 
        点 Create Service。
       

4. 
      检查 Ceph 对象网关服务已启动且正在运行。
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其它资源

      请参阅 Red Hat Ceph Storage Object Gateway 指南中的 为 Beast 配置 SSL 部分。
     

12.3. 在控制面板中为 CEPH 对象网关配置高可用性

    ingress 服务为 Ceph 对象网关提供高可用性端点。您可以使用 Ceph 控制面板创建和配置 ingress 服
务。
   

先决条件

      一个正在运行的 Red Hat Ceph Storage 集群。
     

      最少两个 Ceph 对象网关守护进程在不同主机上运行。
     

      已安装仪表板。
     

      正在运行的 rgw 服务。
     

流程

1. 
      在仪表板导航中，前往 Administration→Services。
     

2. 
      点 Create。
     

3. 
      在 Create Service 表单中，选择 ingress 服务。
     

4. 
      选择后端服务并编辑所需的参数。
     

图 12.2. 创建 入口 服务
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图 12.2. 创建 入口 服务

5. 
      点 Create Service。
     

      通知显示 ingress 服务已被成功创建。
     

其它资源

      有关 入口 服务的更多信息 ，请参阅 Ceph 对象网关的高可用性。
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12.4. 在控制面板中管理 CEPH 对象网关用户

    作为存储管理员，Red Hat Ceph Storage 控制面板可以查看和管理 Ceph 对象网关用户。
   

先决条件

      一个正在运行的 Red Hat Ceph Storage 集群。
     

      已安装仪表板。
     

      已安装 Ceph 对象网关。
     

      对象网关登录凭据添加到仪表板中。
     

12.4.1. 在控制面板中创建 Ceph 对象网关用户

     在使用 CLI 设置凭据后，您可以在 Red Hat Ceph Storage 上创建 Ceph 对象网关用户。
    

先决条件

       一个正在运行的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

       已安装 Ceph 对象网关。
      

       对象网关登录凭据添加到仪表板中。
      

流程

1. 
       在仪表板导航中，进入 Object→Users。
      

2. 
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2. 
       在 Users 选项卡中，单击 Create。
      

3. 
       创建用户 表单，设置以下参数：
      

a. 
         输入 用户 ID 和 全名。
        

b. 
         如果需要，编辑存储桶的最大数量。
        

c. 
         可选： 电子邮件地址
        

d. 
         可选：如果用户是 Suspended 或 System 用户，则选择。
        

e. 
         可选：在 S3 key 部分中，通过清除 Auto-generate 键选择设置自定义 access key 和  
secret key。
        

f. 
         可选：在 User quota 部分中，选择用户配额为 Enabled, sumsize, 或 has Unlimited 
objects。如果有有限大小，请输入最大大小。如果有有限的对象，请输入最大对象。
        

g. 
         可选：在 Bucket quota 部分中，选择 bucket 配额为 Enabled、Ranoid size 或 
hasRESPONSE objects。如果有有限大小，请输入最大大小。如果有有限的对象，请输入
最大对象。
        

4. 
       点 Create User.
      

图 12.3. 创建 Ceph 对象网关用户
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图 12.3. 创建 Ceph 对象网关用户

       通知显示用户创建成功。
      

其它资源

       如需更多信息，请参阅 Red Hat Ceph Storage Dashboard 指南中的手动将 Ceph 对象网关
登录凭证添加到仪表板 部分。
      

       如需更多信息，请参阅 Red Hat Ceph Storage 对象网关指南。
      

12.4.2. 在控制面板中将角色添加到 Ceph 对象网关用户
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     您可以在 Red Hat Ceph Storage 仪表板上为特定 Ceph 对象网关用户添加角色。
    

先决条件

       已安装 Ceph 对象网关。
      

       Ceph 对象网关登录凭据添加到控制面板中。
      

       Ceph 对象网关用户已创建。
      

流程

1. 
       登录到仪表板。
      

2. 
       在导航栏中，单击 Object Gateway。
      

3. 
       单击 Roles。
      

4. 
       点相关行来选择用户。
      

5. 
       在 Edit 下拉菜单中，选择 Create Role。
      

6. 
       在 Create Role 窗口中，配置 Role name,Path, 和 Assume Role Policy Document。
      

图 12.4. 创建 Ceph 对象网关子用户
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图 12.4. 创建 Ceph 对象网关子用户

7. 
       单击 Create Role。
      

12.4.3. 在控制面板中创建 Ceph 对象网关子用户

     子用户与 S3 接口用户关联。您可以在 Red Hat Ceph Storage 仪表板中为特定的 Ceph 对象网关用
户创建子用户。
    

先决条件

       一个正在运行的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

       已安装 Ceph 对象网关。
      

       对象网关登录凭据添加到仪表板中。
      

       创建对象网关用户。
      

流程

1. 
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1. 
       在仪表板导航中，进入 Object→Users。
      

2. 
       在 Uers 选项卡上，选择一个用户，然后单击 编辑。
      

3. 
       在 Edit User 表单中，单击 Create Subuser。
      

4. 
       在 Create Subuser 对话框中，输入用户名并选择适当的权限。
      

5. 
       选择 Auto-generate secret 框，然后单击 Create Subuser。
      

图 12.5. 创建 Ceph 对象网关子用户

注意
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注意

        通过选择 Auto-generate-secret，对象网关的 secret 密钥会自动生成。
       

6. 
       在 Edit User 表单中，单击 Edit user。
      

       通知显示用户已被成功更新。
      

12.4.4. 为 Ceph 对象网关用户添加角色

     您可以在 Red Hat Ceph Storage Dashboard 上向特定的 Ceph 对象网关用户添加角色。
    

先决条件

       已安装 Ceph 对象网关。
      

       Ceph 对象网关登录凭据添加到仪表板中。
      

       Ceph 对象网关用户已创建。
      

流程

1. 
       在仪表板导航中，进入 Object→Users，然后点击 Roles 选项卡。
      

2. 
       点 Create。
      

3. 
       在 Create Pool 表单中，输入 Role name,Path, and Assume Role Policy Document 字
段。
      

4. 
       单击 Create Role。
      

图 12.6. 创建角色表单
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图 12.6. 创建角色表单

5. 
       点 Edit Pool 保存更改。
      

       通知显示该角色创建成功。
      

12.4.5. 在控制面板中编辑 Ceph 对象网关用户

其它资源

      在使用 CLI 设置凭据后，您可以编辑 Red Hat Ceph Storage 上的 Ceph 对象网关用户。
     

先决条件

       一个正在运行的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

       已安装 Ceph 对象网关。
      

       对象网关登录凭据添加到仪表板中。
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       创建了 Ceph 对象网关用户。
      

流程

1. 
       在仪表板导航中，进入 Object→Users。
      

2. 
       在 Users 选项卡中，选择 user 行，再单击 Edit。
      

3. 
       在 Edit User 表单中，编辑所需的参数，再点 Edit User。
      

图 12.7. 编辑 Ceph 对象网关用户

       通知显示用户已被成功更新。
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其它资源

       如需更多信息，请参阅 Red Hat Ceph Storage Dashboard 指南中的手动将 Ceph 对象网关
登录凭证添加到仪表板 部分。
      

       如需更多信息，请参阅 Red Hat Ceph Storage 对象网关指南。
      

12.4.6. 在仪表板上删除 Ceph 对象网关用户

     在使用 CLI 设置凭据后，您可以删除 Red Hat Ceph Storage 上的 Ceph 对象网关用户。
    

先决条件

       一个正在运行的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

       已安装 Ceph 对象网关。
      

       对象网关登录凭据添加到仪表板中。
      

       创建了 Ceph 对象网关用户。
      

流程

1. 
       在仪表板导航中，进入 Object→Users。
      

2. 
       选择要删除的 Username，然后从操作下拉菜单中选择 Delete。
      

3. 
       在 Delete user notification 中，选择 Yes, I am sure 并点 Delete User。
      

       用户已从 Users 表中删除。
      

图 12.8. 删除 Ceph 对象网关用户
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图 12.8. 删除 Ceph 对象网关用户

其它资源

       如需更多信息，请参阅 Red Hat Ceph Storage Dashboard 指南中的手动将 Ceph 对象网关
登录凭证添加到仪表板 部分。
      

       如需更多信息，请参阅 Red Hat Ceph Storage 对象网关指南。
      

12.5. 在控制面板中管理 CEPH 对象网关 BUCKET

    作为存储管理员，Red Hat Ceph Storage 控制面板可以查看和管理 Ceph 对象网关 bucket。
   

先决条件

      一个正在运行的 Red Hat Ceph Storage 集群。
     

      已安装仪表板。
     

      已安装 Ceph 对象网关。
     

      至少创建一个 Ceph 对象网关用户。
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      对象网关登录凭据添加到仪表板中。
     

12.5.1. 在控制面板中创建 Ceph 对象网关存储桶

     在使用 CLI 设置凭据后，您可以在 Red Hat Ceph Storage 上创建 Ceph 对象网关存储桶。
    

先决条件

       一个正在运行的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

       已安装 Ceph 对象网关。
      

       对象网关登录凭据添加到仪表板中。
      

       对象网关用户已创建且不暂停。
      

流程

1. 
       在仪表板导航中，进入 Object→Buckets。
      

2. 
       点 Create。
      

       显示 Create Bucket 表单。
      

3. 
       输入 存储桶的名称。
      

4. 
       选择 所有者。所有者是没有暂停的用户。
      

5. 
       选择一个 放置目标。
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重要

        创建后无法更改存储桶的放置目标。
       

图 12.9. 创建 Ceph 对象网关存储桶

6. 
       可选：在 锁定 部分中，选择 Enabled 来为存储桶对象启用锁定。
      

重要

        只能在创建存储桶时启用锁定，且创建后无法更改。
       

a. 
         选择 Mode，可以是 Compliance 或 Governance。
        

b. 
         在 Days 字段中，选择应用于此存储桶中新对象的默认保留周期。
        

7. 
       可选：在 Security 部分中，选择 Security to encrypt objects in the bucket。
      

a. 
         设置 SSE-S3 的配置值。单击 Encryption information 图标，然后单击 此处。
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注意

          在使用 SSE-S3 加密类型时，Ceph 管理用户存储在密码库中的加密密
钥。
         

i. 
           在 Update RGW Encryption Configuration 对话框中，确保 SSE-S3 被选为 
Encryption Type。
          

ii. 
           填写其他所需信息。
          

iii. 
           点 Submit。
          

图 12.10. 加密存储桶中的对象
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图 12.10. 加密存储桶中的对象

8. 
       点 Create bucket。
      

       通知显示存储桶已创建成功。
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12.5.2. 在控制面板中编辑 Ceph 对象网关存储桶

     在使用 CLI 设置凭据后，您可以编辑 Red Hat Ceph Storage 上的 Ceph 对象网关存储桶。
    

先决条件

       一个正在运行的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

       已安装 Ceph 对象网关。
      

       对象网关登录凭据添加到仪表板中。
      

       对象网关用户已创建且不暂停。
      

       创建 Ceph 对象网关 bucket。
      

流程

1. 
       登录到仪表板。
      

2. 
       在导航栏中，单击 Object Gateway。
      

3. 
       点 Buckets。
      

4. 
       要编辑存储桶，请点击它所在的行。
      

5. 
       从 Edit 下拉菜单中选择 Edit。
      

6. 
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6. 
       在 Edit bucket 窗口中，从下拉菜单选择该用户来编辑所有者。
      

图 12.11. 编辑 Ceph 对象网关存储桶

a. 
         可选：启用 Versioning，如果要为现有存储桶中的所有对象启用版本控制状态。
        

           要启用版本控制，您必须是存储桶的所有者。
          

           如果在创建存储桶的过程中启用了锁定，则无法禁用版本控制。
          

           添加到存储桶的所有对象都将接收唯一的版本 ID。
          

           如果存储桶中没有设置 versioning 状态，则存储桶将没有版本控制状态。
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b. 
         可选：为 Multi-Factor Authentication. 选中 Delete enabled。多因素身份验证(MFA)
确保在删除特定存储桶上的对象时，需要使用一次性密码(OTP)。为 Token Serial Number 
和 Token PIN 输入一个值。
        

注意

          bucket 必须配置有版本控制和 MFA，才能通过 S3 API 进行。
         

7. 
       点 Edit Bucket。
      

8. 
       您会收到成功更新存储桶的通知。
      

12.5.3. 删除仪表板上的 Ceph 对象网关存储桶

     在使用 CLI 设置凭据后，您可以删除 Red Hat Ceph Storage 上的 Ceph 对象网关存储桶。
    

先决条件

       一个正在运行的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

       已安装 Ceph 对象网关。
      

       对象网关登录凭据添加到仪表板中。
      

       对象网关用户已创建且不暂停。
      

       创建 Ceph 对象网关 bucket。
      

流程

1. 

第 12 章 使用控制面板管理 CEPH 对象网关

151



1. 
       在仪表板导航中，进入 Object→Buckets。
      

2. 
       选择要删除的存储桶，然后从操作下拉菜单中选择 Delete。
      

3. 
       在 Delete Bucket notification 中，选择 Yes, I am sure 并点 Delete bucket。
      

图 12.12. 删除 Ceph 对象网关存储桶

12.6. 在 CEPH 仪表板上监控多站点对象网关配置

    Red Hat Ceph Storage 仪表板支持监控多站点对象网关配置中某个区域的用户和 bucket。例如，如
果在主站点的区域中创建了用户和存储桶，您可以在次要站点的二级区域中监控这些用户和 bucket。
   

先决条件

      至少在运行两个站点上部署的 Red Hat Ceph Storage 集群。
     

      已安装仪表板。
     

      多站点对象网关是在主站点和从属站点上配置的。
     

      主站点和次要站点的对象网关登录凭据添加到仪表板中。
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      在主站点上创建对象网关用户。
     

      对象网关 bucket 在主站点创建。
     

流程

1. 
      在辅助站点的仪表板导航中，进入 Object→Buckets。
     

2. 
      在主站点中为 Object Gateway 用户创建的二级登录页面上，查看 Object Gateway 
bucket。
     

图 12.13. 多站点对象网关监控

其它资源

      有关配置多站点的更多信息，请参阅 Red Hat Ceph Storage Object Gateway 指南中的多站
点配置和管理 部分。
     

      有关在仪表板中添加对象网关登录凭证的更多信息，请参阅 Red Hat Ceph Storage 
Dashboard指南中的手动将 Ceph 对象网关登录凭证添加到仪表板   部分。
     

      有关在控制面板上创建对象网关用户的更多信息，请参阅 Red Hat Ceph Storage 
Dashboard指南中的在仪表板上创建 Ceph 对象网关用户   部分。
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      有关在控制面板上创建对象网关存储桶的更多信息，请参阅 Red Hat Ceph Storage 
Dashboard 指南中的在仪表板上创建 Ceph 对象网关存储桶部分。
     

12.7. 在控制面板中，查看每个用户的 CEPH 对象网关和每个存储桶性能计数器

    您可以在 Grafana 仪表板中为每个存储桶查看 Ceph 对象网关性能计数器。
   

先决条件

      一个正在运行的 Red Hat Ceph Storage 集群。
     

      已安装仪表板。
     

      已安装 Grafana。
     

      已安装 Ceph 对象网关。
     

      对象网关登录凭据添加到仪表板中。
     

      对象网关用户已创建且不暂停。
     

      为 Ceph 对象网关服务配置以下参数：
     

# ceph config set <rgw-service> <param> <value>
"rgw_bucket_counters_cache": "true"
"rgw_user_counters_cache": "true"

流程

1. 
      登录到 Grafana URL。
     

语法
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https://DASHBOARD_URL:3000

      

示例

       

https://dashboard_url:3000

      

2. 
      转至"仪表板"选项卡并搜索"RGW S3 Analytics"。
     

3. 
      要查看每个存储桶 Ceph 对象网关操作，请选择 'Bucket' 面板：
     

4. 
      要查看用户级 Ceph 对象网关操作，请选择"用户"面板：
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注意

     per-bucket/per-user get operation count 命令的输出会增加每个从 client 运行的 
'get' 操作的两个值： s3cmd。这是个已知问题。
    

12.8. 在控制面板中管理 CEPH 对象网关存储桶策略

    作为存储管理员，Red Hat Ceph Storage 控制面板可以查看和管理 Ceph 对象网关存储桶策略。
   

先决条件

      一个正在运行的 Red Hat Ceph Storage 集群。
     

      已安装仪表板。
     

      已安装 Ceph 对象网关。
     

      至少创建一个 Ceph 对象网关用户。
     

      Ceph 对象网关登录凭据添加到仪表板中。
     

      至少一个 Ceph 对象网关 bucket。有关创建存储桶的更多信息，请参阅 在仪表板上创建 
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Ceph 对象网关存储桶。
     

12.8.1. 在控制面板中创建和编辑 Ceph 对象网关存储桶策略

     您可以在 Red Hat Ceph Storage 仪表板中创建和编辑 Ceph 对象网关存储桶策略。
    

先决条件

       一个正在运行的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

       已安装 Ceph 对象网关。
      

       至少创建一个 Ceph 对象网关用户。
      

       Ceph 对象网关登录凭据添加到仪表板中。
      

       至少一个 Ceph 对象网关 bucket。有关创建存储桶的更多信息，请参阅 在仪表板上创建 
Ceph 对象网关存储桶。
      

流程

1. 
       从仪表板中，前往 Object → Buckets。
      

2. 
       为现有存储桶创建或修改存储桶策略。
      

注意

        要在存储桶创建过程中创建存储桶策略，点 Create 并填写 Create Bucket 表
单的 Policies 部分中的 bucket 策略信息。
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       选择创建或修改存储桶策略的存储桶，然后单击 Edit。
      

3. 
       在 Create Bucket 表单中，前往 Policies。
      

4. 
       以 JSON 格式输入或修改策略。
      

       在表单中使用以下链接来帮助创建存储桶策略。这些链接在浏览器中打开一个新标签页。
      

         策略生成器 是 AWS 的外部工具，用于生成存储桶策略。如需更多信息，请参阅 AWS 
策略生成器。
        

注意

          您可以将策略生成器与 S3 Bucket Policy 类型一起使用，作为构建 
Ceph 对象网关存储桶策略的指导行。
         

         策略示例 会进入 AWS 文档，以及存储桶策略示例。
        

5. 
       要保存存储桶策略，请点击 Edit Bucket。
      

注意

        在初始存储桶创建过程中创建存储桶策略时，点 Create Bucket。
       

       保存存储桶策略时，会显示 Updated Object Gateway bucket 'bucketname' 通知。
      

12.8.2. 删除仪表板上的 Ceph 对象网关存储桶策略

     您可以删除 Red Hat Ceph Storage 仪表板上的 Ceph 对象网关存储桶策略。
    

先决条件
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       一个正在运行的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

       已安装 Ceph 对象网关。
      

       至少创建一个 Ceph 对象网关用户。
      

       Ceph 对象网关登录凭据添加到仪表板中。
      

       至少一个 Ceph 对象网关 bucket。有关创建存储桶的更多信息，请参阅 在仪表板上创建 
Ceph 对象网关存储桶。
      

流程

1. 
       从仪表板中，前往 Object → Buckets。
      

2. 
       选择创建或修改存储桶策略的存储桶，然后单击 Edit。
      

3. 
       在 Edit Bucket 表单中，前往 Policies。
      

4. 
       单击 Clear。
      

5. 
       要完成存储桶策略删除，请点 Edit Bucket。
      

       删除存储桶策略时，会显示 Updated Object Gateway bucket 'bucketname' 通知。
      

12.9. 在 CEPH 仪表板上管理多站点对象配置的存储桶

    作为存储管理员，您可以在 Red Hat Ceph Storage Dashboard 的另一个区中编辑一个区域的存储
桶。但是，您可以删除主站点中的次要站点的存储桶。您不能删除其他站点中主站点的 master 区域的存
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储桶。例如，如果在二级站点的区域中创建存储桶，您可以在主站点的 master zone 中编辑和删除这些
存储桶。
   

先决条件

      至少在运行两个站点上部署的 Red Hat Ceph Storage 集群。
     

      已安装仪表板。
     

      多站点对象网关是在主站点和从属站点上配置的。
     

      主站点和次要站点的对象网关登录凭据添加到仪表板中。
     

      在主站点上创建对象网关用户。
     

      对象网关 bucket 在主站点创建。
     

      Ceph 控制面板中至少具有 rgw-manager 的访问权限级别。
     

12.9.1. 监控多站点对象的存储桶

     在控制面板中监控 bucket 的多站点同步状态。您可以在 Ceph Dashboard 上查看源区和来自 
Object→Multi-site 的同步状态。
    

     多站点同步状态分为两个部分：
    

主源区域

        显示 Ceph 对象网关连接到的默认域、zonegroup 和区域。
       

源区

        查看元数据同步状态和数据同步信息进度。当您点状态时，会显示分片同步的分类。同步状态显
示 Last Synced 时间戳，与当前时间相关的最后一次同步发生的时间。同步完成后，这会显示为 Up 
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to Date。当无法捕获同步状态时，其状态显示为 Syncing。但是，Last sync 显示同步的天数。通过
单击 Syncing，它会显示有关未同步的分片的详细信息。
       

12.9.2. 在 Ceph 控制面板中编辑多站点对象网关配置的存储桶

     您可以在多站点对象网关配置中，在 Red Hat Ceph Storage Dashboard 的另一个区中编辑和更新一
个区域的存储桶详情。您可以使用控制面板的此功能编辑存储桶的所有者、版本、多因素身份验证和锁定
功能。
    

先决条件

       至少在运行两个站点上部署的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

       多站点对象网关是在主站点和从属站点上配置的。
      

       主站点和次要站点的对象网关登录凭据添加到仪表板中。
      

       在主站点上创建对象网关用户。
      

       对象网关 bucket 在主站点创建。
      

       Ceph 控制面板中至少具有 rgw-manager 的访问权限级别。
      

流程

1. 
       在辅助站点的仪表板导航中，进入 Object→Buckets。
      

       此时会显示主站点的 Object Gateway bucket。
      

2. 
       选择您要编辑的存储桶，然后从操作下拉列表中点 Edit。
      

3. 
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3. 
       在 Edit Bucket 表单中，编辑所需的 prameters，然后点 Edit Bucket。
      

       此时会显示成功更新存储桶的通知。
      

图 12.14. 编辑多站点中的存储桶

其它资源

       有关在仪表板中添加对象网关登录凭证的更多信息，请参阅 Red Hat Ceph Storage 
Dashboard指南中的手动将 Ceph 对象网关登录凭证添加到 Ceph 仪表板  部分。
      

       有关在控制面板上创建对象网关用户的更多信息，请参阅 Red Hat Ceph Storage 
Dashboard指南中的 Ceph 仪表板上创建 Ceph 对象网关用户  部分。
      

       有关在控制面板上创建对象网关存储桶的更多信息，请参阅 Red Hat Ceph Storage 仪表板
指南中的在 Ceph 仪表板中创建  Ceph 对象网关存储桶  部分。
      

       如需有关系统角色的更多信息，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph 仪
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表板上管理角色 部分。
      

12.9.3. 在 Ceph 控制面板中删除多站点对象网关配置的存储桶

     您可以在多站点对象网关配置中，在 Red Hat Ceph Storage Dashboard 的主站点中删除二级站点的
存储桶。
    

重要

      红帽不推荐从二级站点中删除主站点的存储桶。
     

先决条件

       至少在运行两个站点上部署的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

       多站点对象网关是在主站点和从属站点上配置的。
      

       主站点和次要站点的对象网关登录凭据添加到仪表板中。
      

       对象网关用户在主站点上创建。
      

       对象网关存储桶在主站点上创建。
      

       Ceph 控制面板中至少具有 rgw-manager 的访问权限级别。
      

流程

1. 
       在主站点的仪表板导航中，进入 Object→Buckets。
      

2. 
       选择要删除的二级站点的存储桶，然后从操作下拉列表中点 Delete。
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3. 
       在 Delete Bucket notification 中，选择 Yes, I am sure 并点 Delete bucket。
      

       bucket 从 Buckets 表中删除。
      

其它资源

       有关配置多站点的更多信息，请参阅 Red Hat Ceph Storage Object Gateway 指南中的多
站点配置和管理 部分。
      

       有关在仪表板中添加对象网关登录凭证的更多信息，请参阅 Red Hat Ceph Storage 
Dashboard 指南中的 手动将对象网关登录凭证添加到 Ceph 仪表板  部分。
      

       有关在控制面板上创建对象网关用户的更多信息，请参阅 Red Hat Ceph Storage 
Dashboard 指南中的 Ceph 仪表板上创建对象网关用户  部分。
      

       有关在控制面板上创建对象网关存储桶的更多信息，请参阅 Red Hat Ceph Storage 
Dashboard 指南中的 Ceph 仪表板上创建对象网关存储桶  部分。
      

       如需有关系统角色的更多信息，请参阅 Red Hat Ceph Storage 仪表板指南中的 Ceph 仪表
板上的系统角色 部分。
      

12.10. 在 CEPH 仪表板上配置多站点对象网关

    您可以在 Red Hat Ceph Storage Dashboard 上配置 Ceph 对象网关多站点。
   

先决条件

      在两个站点上部署的 Red Hat Ceph Storage 集群。
     

      在两个站点上至少安装了一个 Ceph 对象网关服务。
     

流程

1. 
      启用 Ceph 对象网关模块，以便在主站点和次要站点上导入/导出。
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a. 
        在二级站点的仪表板导航中，进入 Object→Multi-site。
       

b. 
        若要访问导入/导出功能，必须启用 rgw 模块  注释，单击 Enable。
       

2. 
      在主站点仪表板上，创建一个默认的 realm、zonegroup 和 zone。
     

a. 
        单击 Create Realm。
       

b. 
        在 Create Realm 表单中，提供一个 realm 名称，然后选择 Default。
       

c. 
        单击 Create Realm。
       

d. 
        从操作下拉列表中点 Create Zone Group。
       

e. 
        在 Create Zone Group 表单中，提供 zone group name、Ceph Object Gateway 端
点，然后选择 Default。
       

f. 
        单击 Create Zone Group。
       

g. 
        从操作下拉列表中点 Create Zone。
       

h. 
        在 Create Zone 表单中，提供 Zone Name，选择 Default，并提供主站点的 Ceph 对象
网关端点。对于用户，为用户提供系统特权的 access 和 secret key。
       

注意

         在创建区时，红帽建议提供仪表板默认用户 dashboard 的访问密钥和 
secret 密钥。
        

i. 
        单击 Create Zone。
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        此时会显示警告，以重新启动 Ceph 对象网关服务，以完成区域创建。
       

3. 
      重新启动 Ceph 对象网关服务。
     

a. 
        在辅助站点的仪表板导航中，前往 Administration→Services。
       

b. 
        选择 Ceph 对象网关服务行，再展开行。
       

c. 
        在 Daemons 选项卡中选择主机名。
       

d. 
        从操作下拉列表中点 Restart。
       

4. 
      在仪表板中，在 Object→Overview 中，您会收到 "The Object Gateway Service is not 
configured" 的错误。这个程序错误是一个已知问题。请参阅 BZ#2231072。
     

a. 
        作为临时解决方案，请在命令行界面中设置 Ceph 对象网关凭证。
       

语法

         

ceph dashboard set-rgw-credentials
RGW credentials configured

        

b. 
        进入 Object→Overview，验证您是否能够访问仪表板上的 Ceph 对象网关。
       

5. 
      在主站点上创建复制用户。您可以使用以下两个选项：
     

        使用 CLI 创建用户：
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示例

         

[ceph: root@host01 /]# radosgw-admin user create --uid="uid" --display-
name="displayname" --system

        

        从仪表板创建用户，并通过 CLI 修改用户：
       

示例

         

[ceph: root@host01 /]# radosgw-admin user modify --uid="uid" --system

        

6. 
      在仪表板导航中，进入 Object→Users。
     

7. 
      展开用户行并从 Keys 中，单击 Show。
     

a. 
        使用 Copy to Clipboard 复制访问和 secret 密钥。
       

        后续步骤中会用到它们。
       

8. 
      从主站点仪表板中，前往 Object→Multi-site。
     

a. 
        在 Topology Viewer 中，选择区域并点 Edit 图标。
       

b. 
        在 Edit Zone 表单中，粘贴 S3 access key 字段中的访问密钥，以及 S3 secret key 字
段中的 secret 密钥。使用之前复制的密钥。
       

c. 
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c. 
        单击 Edit Zone。
       

9. 
      单击 Export。
     

a. 
        在 Export Multi-site Realm Token 对话框中复制令牌。
       

10. 
      从第二个站点，前往 Object→Multi-site。
     

11. 
      单击 Import，从主区域 导入 令牌。
     

a. 
        在 Import Multi-site Token 对话框中，在 Zone 部分中粘贴之前复制的令牌，并提供 
second zone 名称。
       

b. 
        在 Service 部分中，选择要创建新 Ceph 对象网关服务的放置和端口。
       

c. 
        点 Import。
       

        此时会显示一个警告，以重新启动 Ceph 对象网关服务。
       

12. 
      重新启动 Ceph 对象网关服务。
     

a. 
        在辅助站点的仪表板导航中，前往 Administration→Services。
       

b. 
        选择 Ceph 对象网关服务行，再展开行。
       

c. 
        在 Daemons 选项卡中选择主机名。
       

d. 
        从操作下拉列表中点 Restart。
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        等待用户同步到次要站点。
       

13. 
      使用以下命令验证同步是否已完成：
     

语法

       

radosgw-admin sync status
radosgw-admin user list

      

示例

       

[ceph: root@host01 /]# radosgw-admin sync status
[ceph: root@host01 /]# radosgw-admin user list

      

14. 
      在 Object→Overview 中，您会收到 "The Object Gateway Service is not configured" 的
错误。这个程序错误是一个已知问题。请参阅 BZ#2231072。
     

a. 
        作为临时解决方案，请在命令行界面中设置 Ceph 对象网关凭证。
       

语法

         

ceph dashboard set-rgw-credentials
RGW credentials configured

        

b. 
        进入 Object→Overview，验证您是否能够访问仪表板上的 Ceph 对象网关。
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15. 
      在主站点的 Object→Overview 中，在 Multi-Site Sync Status 部分中会显示一个错误，因
为在二级区上可以看到端点，主机名不是 IP 地址。在配置多站点时，这个程序错误是一个已知问
题。请参阅 BZ#2242994。
     

a. 
        作为临时解决方案，从二级站点仪表板中进入 Object→Multi-site。
       

b. 
        选择 second zone 并单击 Edit 图标。
       

c. 
        编辑端点以反映 IP 地址。
       

d. 
        单击 Edit Zone。
       

16. 
      在主站点和次要站点仪表板中，来自 Object→Overview，在 Multi-Site Sync Status 部分中
会显示状态。
     

验证

      在主站点上创建用户。您会看到用户与二级站点同步。
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第 13 章 使用 CEPH 仪表板管理块设备

   作为存储管理员，您可以在 Red Hat Ceph Storage 仪表板中管理和监控块设备镜像。这个功能在通用
镜像功能和镜像功能之间划分。例如，您可以创建新镜像，查看集群中镜像的镜像状态，以及设置镜像的 
IOPS 限制。
  

13.1. 在 CEPH 仪表板上管理块设备镜像

    作为存储管理员，您可以使用 Red Hat Ceph Storage 仪表板创建、编辑、复制、清除和删除镜像。
   

    您还可以使用 Ceph 控制面板创建、克隆、复制、回滚和删除镜像的快照。
   

注意

     块设备镜像表被分页，用于 10000+ 镜像存储集群，以减少块设备信息检索成本。
    

13.1.1. 在 Ceph 仪表板上创建镜像

     您可以在 Red Hat Ceph Storage 仪表板中创建块设备镜像。
    

先决条件

       一个正在运行的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

       创建启用了 rbd 应用的池。
      

流程

1. 
       在仪表板导航中，进入 Block→Images。
      

2. 
       在 Images 选项卡中，单击 Create。
      

3. 
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3. 
       在 Create RBD 表单中填写表单。
      

4. 
       可选：点 Advanced 设置高级参数，如 条带化 和服务质量。
      

5. 
       单击 Create RBD。
      

       通知显示镜像创建成功。
      

图 13.1. 创建块设备镜像

其它资源

       有关镜像的更多信息，请参阅 Red Hat Ceph Storage 块设备指南。
      

       如需了解更多详细信息，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph仪表板中
创建池  部分。
      

13.1.2. 在 Ceph 仪表板上创建命名空间
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     您可以在 Red Hat Ceph Storage 仪表板中为块设备镜像创建命名空间。
    

     创建命名空间后，您可以为这些命名空间授予用户访问权限。
    

先决条件

       一个正在运行的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

       创建启用了 rbd 应用的池。
      

流程

1. 
       在仪表板导航中，进入 Block→Images。
      

2. 
       在 Namespaces 选项卡中，点 Create。
      

3. 
       在 Create Namespace 对话框中，选择池并为命名空间输入一个名称。
      

4. 
       点 Create。
      

       通知显示命名空间创建成功。
      

图 13.2. 创建命名空间
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图 13.2. 创建命名空间

其它资源

       如需了解更多详细信息，请参阅知识库文章隔离命名空间中的 Segregate Block device 镜
像。
      

13.1.3. 在 Ceph 仪表板上编辑镜像

     您可以在 Red Hat Ceph Storage 仪表板上编辑块设备镜像。
    

先决条件

       一个正在运行的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

       创建启用了 rbd 应用的池。
      

       已创建一个镜像。
      

流程

1. 
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1. 
       在仪表板导航中，进入 Block→Images。
      

2. 
       在 Images 选项卡中，选择要编辑的镜像，然后点 Edit。
      

3. 
       在 Edit RBD 表单中，编辑所需的参数，再单击 Edit RBD。
      

       通知显示镜像已被成功更新。
      

图 13.3. 编辑块设备镜像

其它资源

       有关镜像的更多信息，请参阅 Red Hat Ceph Storage 块设备指南。
      

       如需了解更多详细信息，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph仪表板中
创建池  部分。
      

13.1.4. 在 Ceph 仪表板上复制镜像
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     您可以在 Red Hat Ceph Storage 仪表板中复制块设备镜像。
    

先决条件

       一个正在运行的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

       创建启用了 rbd 应用的池。
      

       已创建一个镜像。
      

流程

1. 
       在仪表板导航中，进入 Block→Images。
      

2. 
       在 Images 选项卡中，选择要复制的镜像，然后从操作下拉菜单中选择 Copy。
      

3. 
       在 Copy RBD 表单中，设置所需的参数，再单击 Copy RBD。
      

       通知显示镜像被成功复制。
      

图 13.4. 复制块设备镜像
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图 13.4. 复制块设备镜像

其它资源

       有关镜像的更多信息，请参阅 Red Hat Ceph Storage 块设备指南。
      

       如需了解更多详细信息，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph仪表板中
创建池  部分。
      

13.1.5. 将镜像移到 Ceph 控制面板的垃圾箱

     您可以将块设备镜像移到回收站，然后才能在 Red Hat Ceph Storage 仪表板中删除。
    

先决条件

       一个正在运行的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

第 13 章 使用 CEPH 仪表板管理块设备

177

https://access.redhat.com/documentation/zh-cn/red_hat_ceph_storage/7/html-single/block_device_guide/
https://access.redhat.com/documentation/zh-cn/red_hat_ceph_storage/7/html-single/dashboard_guide/#creating-pools-on-the-ceph-dashboard_dash


       创建启用了 rbd 应用的池。
      

       已创建一个镜像。
      

流程

1. 
       在仪表板导航中，进入 Block→Images。
      

2. 
       在 Images 选项卡中，选择要移到垃圾箱的镜像，然后从操作下拉列表中单击 Move to 
Trash。
      

3. 
       在 Move a images to trash 对话框中，更改 Protection expires at 字段，然后单击 
Move。
      

       通知显示镜像被成功移到回收站中。
      

图 13.5. 将镜像移动到回收站

13.1.6. 在 Ceph 仪表板上清除垃圾箱
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     您可以使用 Red Hat Ceph Storage 控制面板清除垃圾箱。
    

先决条件

       一个正在运行的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

       创建启用了 rbd 应用的池。
      

       镜像被回收。
      

流程

1. 
       在仪表板导航中，进入 Block→Images。
      

2. 
       在 Trash 选项卡中，单击 Purge Trash。
      

3. 
       在 Purge Trash 对话框中，选择池，然后单击 Purge Trash。
      

       通知显示回收站中的池被成功清除。
      

图 13.6. 清除垃圾箱
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图 13.6. 清除垃圾箱

其它资源

       如需了解更多详细信息 ，请参阅 Red Hat Ceph Storage 块设备指南中的 清除 块设备快照
部分。
      

13.1.7. 在 Ceph 仪表板中从回收中恢复镜像

     您可以恢复已回收的镜像，并在 Red Hat Ceph Storage Dashboard 上有到期日期。
    

先决条件

       一个正在运行的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

       创建启用了 rbd 应用的池。
      

       镜像被回收。
      

流程

1. 
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1. 
       在仪表板导航中，进入 Block→Images。
      

2. 
       在 Trash 选项卡中，选择要恢复的镜像行。
      

3. 
       在操作下拉列表中点 Restore。
      

4. 
       在 Restore Image 对话框中，输入镜像的新名称，然后点 Restore。
      

       通知显示镜像已成功恢复。
      

图 13.7. 从回收站中恢复镜像

其它资源

       如需有关在 RBD 池中创建镜像的 更多详细信息，请参阅 Red Hat Ceph Storage 仪表板指
南中的在 Ceph 仪表板中创建镜像部分。
      

13.1.8. 删除 Ceph 仪表板中的镜像

     您可以在 Ceph Dashboard 上从集群中删除镜像。
    

先决条件

第 13 章 使用 CEPH 仪表板管理块设备

181

https://access.redhat.com/documentation/zh-cn/red_hat_ceph_storage/7/html-single/dashboard_guide/#creating-images-on-the-ceph-dashboard_dash


       一个正在运行的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

       创建启用了 rbd 应用的池。
      

       已创建一个镜像。
      

流程

1. 
       在仪表板导航中，进入 Block→Images。
      

2. 
       选择要删除的行，然后从操作下拉菜单中选择 Delete。
      

3. 
       在 Delete RBD 通知中，选择 Yes, I am sure，再单击 Delete RBD。
      

       通知显示镜像已被成功删除。
      

图 13.8. 删除镜像

其它资源

       有关在 RBD 池中创建镜像的更多详细信息，请参阅 Red Hat Ceph Storage Dashboard 
Guide 中的 Moving images to trash on the Ceph dashboard 部分。
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13.1.9. 删除 Ceph 仪表板上的命名空间。

     您可以在 Red Hat Ceph Storage Dashboard 中删除镜像的命名空间。
    

先决条件

       一个正在运行的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

       创建启用了 rbd 应用的池。
      

       在池中创建一个命名空间。
      

流程

1. 
       在仪表板导航中，进入 Block→Images。
      

2. 
       在 Namespaces 选项卡中，选择命名空间并点 Delete from the action-down。
      

3. 
       在 Delete Namespace 通知中，选择 Yes, I am sure 并点 Delete Namespace。
      

       通知显示命名空间已被成功删除。
      

图 13.9. 删除命名空间
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图 13.9. 删除命名空间

13.1.10. 在 Ceph 仪表板中创建镜像快照

     您可以在 Red Hat Ceph Storage Dashboard 上获取 Ceph 块设备镜像的快照。
    

先决条件

       一个正在运行的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

       创建启用了 rbd 应用的池。
      

       已创建一个镜像。
      

流程

1. 
       在仪表板导航中，进入 Block→Images。
      

2. 
       在 Images 选项卡中，展开镜像行。
      

3. 
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3. 
       在 Snapshots 选项卡中，单击 Create。
      

4. 
       在 Create RBD Snapshot 对话框中，输入快照名称，再单击 Create RBD Snapshot。
      

       通知显示快照创建成功。
      

图 13.10. 创建镜像快照

其它资源

       有关 创建快照的更多信息，请参阅 Red Hat Ceph Storage 块设备指南中的 创建块设备快照 
部分。
      

       有关创建 RBD 池的更多详细信息， 请参阅 Red Hat Ceph Storage Dashboard 指南中的  
在 Ceph 仪表板中创建池部分。
      

       如需了解更多详细信息，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph 仪表板中
创建镜像部分。 https://access.redhat.com/documentation/zh-
cn/red_hat_ceph_storage/7/html-single/dashboard_guide/#creating-images-on-the-ceph-
dashboard_dash
      

13.1.11. 在 Ceph 仪表板中重命名镜像的快照

     您可以在 Red Hat Ceph Storage Dashboard 上重命名 Ceph 块设备镜像的快照。
    

先决条件
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       一个正在运行的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

       创建启用了 rbd 应用的池。
      

       已创建一个镜像。
      

       创建镜像的快照。
      

流程

1. 
       在仪表板导航中，进入 Block→Images。
      

2. 
       在 Images 选项卡中，展开镜像行。
      

3. 
       在 Snapshots 选项卡中，单击 Rename。
      

4. 
       在 Rename RBD Snapshot 对话框中，输入新名称，再单击 Rename RBD Snapshot。
      

其它资源

       如需更多信息 ，请参阅 Red Hat Ceph Storage 块设备指南中的重命名 块设备快照部分。
      

       有关创建 RBD 池的更多详细信息， 请参阅 Red Hat Ceph Storage Dashboard 指南中的  
在 Ceph 仪表板中创建池部分。
      

       如需了解更多详细信息，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph 仪表板中
创建镜像部分。 https://access.redhat.com/documentation/zh-
cn/red_hat_ceph_storage/7/html-single/dashboard_guide/#creating-images-on-the-ceph-
dashboard_dash
      

Red Hat Ceph Storage 7 仪表板指南

186

https://access.redhat.com/documentation/zh-cn/red_hat_ceph_storage/7/html-single/block_device_guide/#renaming-a-block-device-snapshot_block
https://access.redhat.com/documentation/zh-cn/red_hat_ceph_storage/7/html-single/dashboard_guide/#creating-pools-on-the-ceph-dashboard_dash
https://access.redhat.com/documentation/zh-cn/red_hat_ceph_storage/7/html-single/dashboard_guide/#creating-images-on-the-ceph-dashboard_dash


13.1.12. 保护 Ceph 仪表板上的镜像快照

     您可以在 Red Hat Ceph Storage Dashboard 上保护 Ceph 块设备镜像的快照。
    

     当您需要克隆快照时，需要这样做。
    

先决条件

       一个正在运行的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

       创建启用了 rbd 应用的池。
      

       已创建一个镜像。
      

       创建镜像的快照。
      

流程

1. 
       在仪表板导航中，进入 Block→Images。
      

2. 
       在 Images 选项卡中，展开镜像行并点 Snapshots 选项卡。
      

3. 
       选择要保护的快照，然后从操作下拉菜单中选择 Protect。
      

       快照更新和 State 从 Unprotected to Protected。
      

其它资源

       如需更多信息 ， 请参阅 Red Hat Ceph Storage 块设备指南中的保护块设备快照部分。
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13.1.13. 在 Ceph 仪表板中克隆镜像的快照

     您可以在 Red Hat Ceph Storage Dashboard 上克隆镜像的快照。
    

先决条件

       一个正在运行的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

       创建启用了 rbd 应用的池。
      

       已创建一个镜像。
      

       镜像的快照会被创建和保护。
      

流程

1. 
       在仪表板导航中，进入 Block→Images。
      

2. 
       在 Images 选项卡中，展开镜像行。
      

3. 
       在 Snapshots 选项卡中，选择要克隆的快照，然后从操作下拉菜单中选择 Clone。
      

4. 
       在 Clone RBD 表单中，填写所需的详细信息，再单击 Clone RBD。
      

       通知显示快照被成功克隆，新镜像显示在 Images 表中。
      

其它资源

       如需更多信息 ， 请参阅 Red Hat Ceph Storage 块设备指南中的保护块设备快照部分。
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       如需了解更多详细信息，请参阅 Red Hat Ceph Storage Dashboard 指南中的保护镜像快照  
部分。
      

13.1.14. 在 Ceph 仪表板中复制镜像的快照

     您可以在 Red Hat Ceph Storage Dashboard 上复制镜像的快照。
    

先决条件

       一个正在运行的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

       创建启用了 rbd 应用的池。
      

       已创建一个镜像。
      

       创建镜像的快照。
      

流程

1. 
       在仪表板导航中，进入 Block→Images。
      

2. 
       在 Images 选项卡中，展开镜像行。
      

3. 
       在 Snapshots 选项卡中，选择要克隆的快照，然后从操作下拉列表中单击 Copy。
      

4. 
       在 Copy RBD 表单中，填写所需的详细信息，再单击 Copy RBD。
      

       通知显示快照被成功克隆，新镜像显示在 Images 表中。
      

其它资源

第 13 章 使用 CEPH 仪表板管理块设备

189

https://access.redhat.com/documentation/zh-cn/red_hat_ceph_storage/7/html-single/dashboard_guide/#protecting-snapshots-of-images-on-the-ceph-dashboard_dash


       有关创建 RBD 池的更多详细信息， 请参阅 Red Hat Ceph Storage Dashboard 指南中的  
在 Ceph 仪表板中创建池部分。
      

       如需了解更多详细信息，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph 仪表板中
创建镜像部分。 https://access.redhat.com/documentation/zh-
cn/red_hat_ceph_storage/7/html-single/dashboard_guide/#creating-images-on-the-ceph-
dashboard_dash
      

13.1.15. 在 Ceph 仪表板中取消保护镜像的快照

     您可以在 Red Hat Ceph Storage Dashboard 上取消保护 Ceph 块设备镜像的快照。
    

     当您需要删除快照时需要这样做。
    

先决条件

       一个正在运行的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

       创建启用了 rbd 应用的池。
      

       已创建一个镜像。
      

       镜像的快照会被创建和保护。
      

流程

1. 
       在仪表板导航中，进入 Block→Images。
      

2. 
       在 Images 选项卡中，展开镜像行并点 Snapshots 选项卡。
      

3. 
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3. 
       选择受保护的快照，然后从 操作下拉菜单中选择 Unprotect。
      

       快照更新和 State 从 Protected 变为 Unprotected*。
      

其它资源

       如需更多信息，请参阅 Red Hat Ceph Storage 块设备指南中的 取消保护块设备快照 部分。
      

       如需了解更多详细信息，请参阅 Red Hat Ceph Storage Dashboard 指南中的保护镜像快照  
部分。
      

13.1.16. 在 Ceph 仪表板上回滚镜像快照

     您可以在 Red Hat Ceph Storage Dashboard 上回滚 Ceph 块设备镜像的快照。将镜像回滚到快照意
味着使用快照中的数据覆盖镜像的当前版本。执行回滚所需的时间会随着镜像大小的增加而增加。从快照
克隆要快于将镜像回滚到快照，而这是返回到预先存在的状态的首选方法。
    

先决条件

       一个正在运行的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

       创建启用了 rbd 应用的池。
      

       已创建一个镜像。
      

       创建镜像的快照。
      

流程

1. 
       在仪表板导航中，进入 Block→Images。
      

2. 

第 13 章 使用 CEPH 仪表板管理块设备

191

https://access.redhat.com/documentation/zh-cn/red_hat_ceph_storage/7/html-single/block_device_guide/#unprotecting-a-block-device-snapshot_block
https://access.redhat.com/documentation/zh-cn/red_hat_ceph_storage/7/html-single/dashboard_guide/#protecting-snapshots-of-images-on-the-ceph-dashboard_dash


2. 
       在 Images 选项卡中，展开镜像行并点 Snapshots 选项卡。
      

3. 
       选择要回滚的快照，并从操作下拉列表中点 Rollback。
      

4. 
       在 RBD 快照回滚 对话框中，单击 Rollback。
      

图 13.11. 镜像的回滚快照

其它资源

       如需更多信息，请参阅 Red Hat Ceph Storage 块设备指南中的 Rolling a block device 
snapshot 部分。
      

       有关创建 RBD 池的更多详细信息， 请参阅 Red Hat Ceph Storage Dashboard 指南中的  
在 Ceph 仪表板中创建池部分。
      

       如需了解更多详细信息，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph 仪表板中
创建镜像部分。 https://access.redhat.com/documentation/zh-
cn/red_hat_ceph_storage/7/html-single/dashboard_guide/#creating-images-on-the-ceph-
dashboard_dash
      

13.1.17. 删除 Ceph 仪表板中的镜像快照

     您可以删除 Red Hat Ceph Storage Dashboard 上的 Ceph 块设备镜像的快照。
    

先决条件

       一个正在运行的 Red Hat Ceph Storage 集群。
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       已安装仪表板。
      

       创建启用了 rbd 应用的池。
      

       已创建一个镜像。
      

       创建镜像的快照并未受保护。
      

流程

1. 
       在仪表板导航中，进入 Block→Images。
      

2. 
       在 Images 选项卡中，展开镜像行。
      

3. 
       在 Snapshots 选项卡中，选择要删除的快照，然后从操作下拉菜单中选择 Delete。
      

4. 
       在 Delete RBD Snapshot 对话框中，选择 Yes, I am sure，再单击 Delete RBD 
Snapshot。
      

       通知显示快照创建成功。
      

其它资源

       如需更多信息 ，请参阅 Red Hat Ceph Storage 块设备指南中的 删除 块设备快照部分。
      

       如需了解更多详细信息，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph仪表板中
的取消保护快照部分 。
      

13.2. 在 CEPH 仪表板上管理镜像功能

    作为存储管理员，您可以在 Red Hat Ceph Storage Dashboard 上管理和监控块设备的镜像功能。
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    您可以通过在存储集群间镜像数据镜像，为 Ceph 块设备添加另一层冗余性。了解和使用 Ceph 块设备
镜像功能可帮助您防止数据丢失，如站点故障。镜像 Ceph 块设备有两种配置，单向镜像或双向镜像，您
可以在池和单个镜像上配置镜像功能。
   

13.2.1. Ceph 仪表板上的镜像视图

     您可以在 Red Hat Ceph Storage Dashboard 上查看块设备镜像。
    

     您可以查看守护进程、站点详情、池以及为块设备镜像配置的镜像。
    

先决条件

       一个正在运行的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

       配置了镜像(mirror)。
      

流程

       在仪表板导航中，进入 Block→Mirroring。
      

图 13.12. 查看 Ceph 块设备的镜像

Red Hat Ceph Storage 7 仪表板指南

194



图 13.12. 查看 Ceph 块设备的镜像

其它资源

       如需有关镜像的更多信息，请参阅 Red Hat Ceph Storage 块设备指南中的镜像 Ceph 块设
备 部分。
      

13.2.2. 在 Ceph 仪表板上编辑池模式

     您可以编辑镜像功能的整体状态模式，其中包括 Red Hat Ceph Storage 仪表板中的池和镜像。
    

先决条件

       一个正在运行的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

       创建启用了 rbd 应用的池。
      

       已创建一个镜像。
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       配置了镜像(mirror)。
      

流程

       在仪表板导航中，进入 Block→Mirroring。
      

1. 
         在池 表中，选择要编辑的池，然后单击 Edit Mode。
        

2. 
         在 Edit Mode 对话框中，选择模式并单击 Update。
        

         通知显示，模式已被成功更新，以及 池 表中的 Mode 更新。
        

其它资源

       如需更多信息，请参阅 Red Hat Ceph Storage 块设备指南中的 Ceph 块设备镜像部分。  
https://access.redhat.com/documentation/zh-cn/red_hat_ceph_storage/7/html-
single/block_device_guide/#ceph-block-device-mirroring_block
      

13.2.3. 在 Ceph 仪表板上为镜像添加对等功能

     您可以为 rbd-daemon 镜像添加存储集群 peer，以便在 Red Hat Ceph Storage Dashboard 上发现
其对等存储集群。
    

先决条件

       两个正常运行的 Red Hat Ceph Storage 集群。
      

       仪表板安装在两个集群上。
      

       使用相同名称创建的池。
      

       在两个集群中 都启用了 RBD 应用。
      

注意
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注意

      确保为在其中创建镜像的池启用镜像功能。
     

流程

      站点 A
     

1. 
       在仪表板导航中，进入 Block → Mirroring，再点击 Create Bootstrap Token。
      

2. 
       在导航菜单中点 Block 下拉菜单，然后点 Mirroring。
      

3. 
       点 Create Bootstrap Token 在窗口中配置以下内容：
      

图 13.13. 创建 bootstrap 令牌
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图 13.13. 创建 bootstrap 令牌

a. 
         对于提供的站点名称，请选择要镜像的池。
        

b. 
         对于所选池，点 Generate 生成新的 bootstrap 令牌。
        

c. 
         单击 Copy to Clipboard。
        

d. 
         单击 Close。
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4. 
       启用池镜像模式。
      

a. 
         选择池。
        

b. 
         单击 Edit Mode。
        

c. 
         在 Edit pool mirror mode 对话框中，从 Mode 列表中选择 Image。
        

d. 
         点 Update。
        

         通知显示池已被成功更新。
        

     Site B
    

1. 
       在仪表板导航中，进入 Block → Mirroring，再从操作下拉列表中点 Import Bootstrap 
Token。
      

注意

        确保为导入 bootstrap 令牌的特定池启用了镜像模式。
       

2. 
       在 Import Bootstrap Token 对话框中，选择方向，并粘贴之前从站点 A 复制的令牌。
      

图 13.14. 导入 bootstrap 令牌
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图 13.14. 导入 bootstrap 令牌

3. 
       点 Submit。
      

       添加 peer，镜像会在站点 B 的集群中镜像。
      

4. 
       在 Block → Mirroring 页面中，在 Pool 表中验证池的健康状况是否处于 OK 状态。
      

     站点 A
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1. 
       创建启用了 镜像的镜像。
      

a. 
         在仪表板导航中，进入 Block → Images。
        

b. 
         在 Images 选项卡上，单击 Create。
        

c. 
         在 Create RBD 表单中，填写 Name 和 Size。
        

d. 
         选择 镜像功能。
        

注意

          使用 Journal 或 Snapshot 选择镜像。
         

e. 
         单击 Create RBD。
        

图 13.15. 创建镜像镜像
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图 13.15. 创建镜像镜像

2. 
       验证镜像在两个站点都可用。
      

a. 
         在 Images 表中，验证站点 A 中的镜像是否已设置为 primary，并且站点 B 中的镜像
是否已设置为 secondary。
        

其它资源

       如需更多信息，请参阅 Red Hat Ceph Storage 块设备指南中的 使用命令行界面配置双向镜
像 部分。
      

13.2.4. 在 Ceph 仪表板上编辑镜像中的对等功能

     您可以编辑 rbd-daemon 镜像的存储集群对等点，以便在 Red Hat Ceph Storage Dashboard 中发现
其对等存储集群。
    

先决条件
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       一个正在运行的 Red Hat Ceph Storage 集群。
      

       已安装仪表板。
      

       创建启用了 rbd 应用的池。
      

       已创建一个镜像。
      

       配置了镜像(mirror)。
      

       添加了对等点。
      

流程

       在仪表板导航中，进入 Block→Mirroring。
      

a. 
         在 Pools 表中，选择要编辑的池，并从操作下拉列表中点 Edit Peer。
        

1. 
           在 Edit pool mirror peer 对话框中，编辑参数，然后点 Submit。
          

           通知显示对等已成功更新。
          

图 13.16. 编辑镜像中的 peer
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图 13.16. 编辑镜像中的 peer

其它资源

       如需更多信息，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph 仪表板中添加对等 
镜像部分。
      

13.2.5. 删除 Ceph 仪表板上的镜像中的对等点

     您可以编辑'rbd-daemon' mirror 的存储集群，以便在 Red Hat Ceph Storage Dashboard 中发现其
对等存储集群。
    

先决条件

       一个正在运行的 Red Hat Ceph Storage 集群。
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       已安装仪表板。
      

       创建启用了 rbd 应用的池。
      

       已创建一个镜像。
      

       配置了镜像(mirror)。
      

       添加了对等点。
      

流程

1. 
       在仪表板导航中，进入 Block→Mirroring。
      

2. 
       在 Pools 表中，选择要编辑的池，并从操作下拉列表中点 Delete Peer。
      

3. 
       在 Delete mirror peer 对话框中，选择 Yes, I am sure 并点 Delete mirror peer。
      

       通知显示对等成功删除。
      

图 13.17. 删除镜像中的 peer
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图 13.17. 删除镜像中的 peer

其它资源

       如需更多信息，请参阅 Red Hat Ceph Storage 仪表板指南中的在 Ceph 仪表板中添加对等 
镜像部分。
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第 14 章 激活和停用遥测

   激活遥测模块，以帮助 Ceph 开发人员了解如何使用 Ceph 以及用户可能遇到的问题。这有助于提高仪
表板体验。激活遥测模块会将有关集群的匿名数据发回到 Ceph 开发人员。
  

   在公共遥测仪表板上 查看发送到 Ceph 开发人员的遥测数据。这允许社区轻松查看报告集群数量、其总
容量和 OSD 数量以及版本分布趋势的摘要统计。
  

   遥测报告分为多个频道，每种频道都有不同类型的信息。假设启用了 telemetry，您可以打开和关闭单
个频道。如果遥测关闭，则每个通道设置无效。
  

基本的

      提供有关集群的基本信息。
     

crash

      提供有关守护进程崩溃的信息。
     

设备

      提供有关设备指标的信息。
     

Ident

      提供用户提供的有关集群的标识信息。
     

perf

      提供集群的各种性能指标。
     

   数据报告包含有助于开发人员更好地了解 Ceph 的使用方式的信息。数据包括集群部署、Ceph 版本、
主机的分发和其他参数的计数器和统计信息。
  

重要

    数据报告不包含池名称、对象名称、对象内容、主机名或设备序列号等任何敏感数据。
   

注意
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注意

    遥测也可以使用 API 进行管理。有关更多信息，请参阅 Red Hat Ceph Storage 
Developer Guide 中的 Telemetry 章节。
   

流程

1. 
     使用以下方法之一激活 telemetry 模块：
    

       从 Ceph 仪表板内的横幅。
      

       进入 Settings→Telemetry 配置。
      

2. 
     选择应启用遥测的每个频道。
    

注意

      有关每种频道类型的详细信息，请点频道旁边的 More Info。
     

3. 
     为集群完成 联系信息。输入联系人、Ceph 集群描述和组织。
    

4. 
     可选：完成 Advanced Settings 字段选项。
    

Interval（间隔）

        将间隔设置为 hour。模块编译并发送每小时间隔的新报告。默认间隔为 24 小时。
       

Proxy

        如果集群无法直接连接到配置的遥测端点，则使用它来配置 HTTP 或 HTTPs 代理服务
器。使用以下格式添加服务器：
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        https://10.0.0.1:8080 或 https://ceph::8080
       

        默认端点为 telemetry.ceph.com。
       

5. 
     点击 Next。这会在启用遥测前显示 Telemetry 报告预览。
    

6. 
     查看 报告预览。
    

注意

      该报告可以在本地下载并保存，或复制到剪贴板中。
     

7. 
     选择 I agree to my telemetry data is submitted in the Community Data License 
Agreement。
    

8. 
     单击 Update 来启用 telemetry 模块。
    

     此时会显示以下信息，确认遥测激活：
    

The Telemetry module has been configured and activated successfully

14.1. 停用遥测

    要取消激活遥测模块，请转至 Settings→Telemetry 配置，然后点 Deactivate。
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